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B Network Interface Board

.. Operating Instructions

Read this manual carefully before you use this product and keep it handy for future
reference.
For safety, please follow the instructions in this manual.




Introduction

To get maximum versatility from this machine all operators should carefully read and follow the instruc-
tions in this manual. Please keep this manual in a handy place near the machine.

Please read the Safety Information in the “Printer Reference” before using this machine. It contains im-
portant information related to USER SAFETY and PREVENTING EQUIPMENT PROBLEMS.
Important

Parts of this manual are subject to change without prior notice. In no event will the company be liable
for direct, indirect, special, incidental, or consequential damages as a result of handling or operating
the machine.

Note

The names of the applications do not appear in the following pages. Confirm which applications you
will be using before reading this manual.

Descriptions in this manual Application

PRINTER MANAGER FOR ADMINISTRATOR | Aficio Manager for Admin
Net Vision for Admin

PRINTER MANAGER FOR CLIENT Aficio Manager for Client
Net Vision for Client

Software Version Conventions Used in This Manual

¢ NetWare 3.x means NetWare 3.12 and 3.2.
¢ NetWare 4.x means NetWare 4.1, 4.11 and IntranetWare.

Trademarks

Apple, AppleTalk, EtherTalk, LaserWriter, Macintosh are registered trademarks of Apple Computer,
Inc.

Ethernet is a registered trademark of Xerox Corporation.

Microsoft, Windows, Windows NT are registered trademarks of Microsoft Corporation in the United
States and/or other countries.

Netscape, Netscape Navigator are registered trademarks of Netscape Communications Corporation.
Novell, NetWare, NDS are registered trademarks of Novell, Inc.

PostScript is a registered trademark of Adobe Systems, Incorporated.

PCL is a registered trademark of Hewlett-Packard Company.

Sun is a registered trademark of Sun Microsystems, Inc.

SunOS is a trademark of Sun Microsystems, Inc.

Other product names used herein are for identification purposes only and might be trademarks of their
respective companies. We disclaim any and all rights in those marks.

Note

The proper names of the Windows operating systems are as follows:

*  Microsoft® Windows® 95 operating system

* Microsoft® Windows® 98 operating system

*  Microsoft® Windows® Millennium Edition (Windows Me)

*  Microsoft® Windows® 2000 Professional

* Microsoft® Windows® 2000 Server

e Microsoft® Windows NT® Server operating system Version 4.0

e Microsoft® Windows NT® Workstation operating system Version 4.0



Manuails for This Printer

There are six manuals that separately describe the procedures for the installation
of a printer and for the operation and maintenance of the printer and its optional
equipment.

To enhance safe and efficient operation of the printer, all users should read and
follow the instructions contained in the following manuals.
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Quick Installation Guide
Describes the procedures for installing the printer.

Setup Guide

Describes the procedures and provides necessary information about install-
ing and setting up the printer and its options. This guide is provided as a
printed manual, and also as a PDF file on the CD-ROM labeled “Printer Driv-
ers and Utilities”.

Printer Reference
Describes the procedures and provides necessary information about using

the printer and its options. The manual is included as a PDF file on the CD-
ROM labeled “Printer Drivers and Utilities”.

RICOH-SCRIPT2 Operating Instructions

Describes the menus and features you can set using the RICOH-SCRIPT2
printer driver. The manual is included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.

Network Interface Board Operating Instructions

Describes the procedures and provides necessary information about setting
up and using the printer in a network environment. The manual is included
as a PDF file on the CD-ROM labeled “Printer Drivers and Utilities” (this
manual).

UNIX Supplement

Provides information about setting up and using the printer in a UNIX envi-
ronment. This manual is included as a PDF file on the CD-ROM labeled
“Printer Drivers and Utilities”.



How to Read This Manual

Symbols

In this manual, the following symbols are used:

/\ WARNING:
This symbol indicates a potentially hazardous situation which, if instructions
are not followed, could result in death or serious injury.

N\ CAUTION:

This symbol indicates a potentially hazardous situation which, if instructions
are not followed, may result in minor or moderate injury or damage to property.

* The statements above are notes for your safety.

ﬂlmportant
If this instruction is not followed, paper might be misfed, originals might be

damaged, or data might be lost. Be sure to read this.

5] Preparation

This symbol indicates the prior knowledge or preparations required before op-
erating.

& Note

This symbol indicates precautions for operation, or actions to take after misop-
eration.

? Limitation

This symbol indicates numerical limits, functions that cannot be used together,
or conditions in which a particular function cannot be used.

A Reference
This symbol indicates a reference.

[ ]

Keys that appear on the machine's panel display.

Keys and buttons that appear on the computer's display.
[ ]

Keys built into the machine's operation panel.
Keys on the computer's keyboard.



Infroduction

This manual contains detailed instructions on configuring the printer as a net-
work printer. Read the section appropriate to your network environment for
how to configure the printer correctly.

Windows 2000,
Windows NT (Server)

Windows 95/98/Me @| /\\
A Sy TS
Windows 2000 D - /
Windows NT @

NetWare @ /
(Client) |~ —
Macintosh @I

S

UNIX

ﬂlmportant

O The procedures written in this manual assume that you are a network admin-
istrator. If you are not, be sure to consult your network administrator before
configuration.

A Reference
For more information about connecting the printer to the host computer with
Network Interface Board, see the Setup Guide that comes with this printer.

For more information about configuring the Network Interface Board with
the operation panel, see the Setup Guide that comes with this printer.

< Features
¢ Support for 100BASE-TX and 10BASE-T
e The Network Interface Board is compatible with NetWare (IPX/SPX),
Windows NT (TCP/IP, NetBEUI, IPP 1), Windows 2000 (TCP/IP, Net-
BEUI, IPP 1), Windows 95/98/Me (TCP/IP, NetBEUI, IPP "), UNIX

(TCP/IP) and Macintosh (AppleTalk) protocols. This allows you to use the
printer in a network that uses different protocols and operating systems.

* A computer used as a dedicated print server is not required because the
Network Interface Board can be configured as a NetWare print server.



*1

The Network Interface Board can connect the printer to the network with-
out requiring its own power supply because the Network Interface Board
is installed inside the printer.

IPP (Internet Printing Protocol) is a protocol for printing via the Internet.



Setting Up the Printer on a Network

Windows 95/98/Me

For how to set up the printer as a network printer in a Windows 95/98/Me en-
vironment, see P.1 “Windows 95/98/Me Configuration”. There are two methods for
using the printer as a network printer.

«Printing Without Using a Print Server “Printing With a Windows 2000 or
Windows NT Print Server

Windows 2000 or

Windows NT Server

(or Workstation)

Print Server

s

TCP/IP
NetBEUI
PP

@?;' N

Windows 95/98/Me Windows 95/98/Me
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Windows 2000

For how to set up the printer as a network printer in a Windows 2000 environ-
ment, see P.15 “Windows 2000 Configuration”. There are two methods for using

the printer as a network printer.

«Printing Without Using a Print Server

“Printing With a Windows 2000 or
Windows NT Print Server
Windows 2000 or

Windows NT Server
(or Workstation)
Print Server

S

—

TCP/IP
NetBEUI
PP

I

Windows 2000

J

Windows 2000

Windows NT 4.0

For how to set up the printer as a network printer in a Windows NT 4.0 environ-
ment, see P.31 “Windows NT 4.0 Configuration”. There are two methods for using

the printer as a network printer.

“Printing Without Using a Print Server

«Printing With a Windows 2000 or
Windows NT Print Server

Windows 2000 or
Windows NT Server
(or Workstation)
Print Server

E?

S

Y

TCP/IP
NetBEUI
PP

LPR <>
J

Windows NT 4.0

Windows NT 4.0



NetWare

For how to set up the printer as a network printer in a NetWare environment,
see P.49 “NetWare Configuration”. The Network Interface Board allows you to
use the printer as either a print server or a remote printer.

For more information about setting up the clients, see the following pages.
* Windows 95/98/Me = P.68 “Windows 95/98/Me”

¢ Windows 2000 = P.69 “Windows 2000”

* Windows NT 4.0 = P.70 “Windows NT 4.0”

Configuring the printer as a print server

A dedicated NetWare print server is not required because the printer can be con-
figured as a print server.

Print Server NetWare
File Server

Ny (7]
N\ N N~
Windows 95/98/Me Windows 2000 Windows NT 4.0

The actual procedures for configuring the printer differ depending on the ver-
sion of NetWare.

* NetWare 3.x = P.54 “Setting Up as a Print Server”
* NetWare 4.x, 5 = P.61 “Setting Up as a Print Server”

Vii
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Configuring the printer as a remote printer

If a dedicated NetWare print server is being used, the printer should be config-
ured as a remote printer.

Remote Printer NetWare NetWare
Print Server File Server
I 5
S

‘ S

Windows 95/98/Me  Windows 2000 Windows NT 4.0
The actual procedures for configuring the printer differ depending on the ver-
sion of NetWare.

* NetWare 3.x = P.57 “Setting Up as a Remote Printer”
* NetWare 4.x, 5 = P.65 “Setting Up as a Remote Printer”

Macintosh

For how to set up the printer as a network printer in a Macintosh environment,
see P.71 “Macintosh Configuration”.

AppleTalk

S

Macintosh



UNIX

For how to setup the printer as a network printer in a UNIX environment, see
the UNIX Supplement included as a PDF file on the CD-ROM.

TCP/IP

UNIX
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1. Windows 95/98/Me

Configuration

Configuring Windows 95/98/Me

Printing Without Using a Print Server

The following procedure describes how to configure Windows 95/98 /Me to use
the printer on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows NT Server, Windows NT Workstation, or NetWare based print
server.

D indicates topics explained in this document

[ 1. Decide on the protocol to use J
Consult your network administrator about which of the three protocols are appropriate.
TCP/IP IPP NetBEUI

{ 2. Configure the chosen protocol J

D "Configuring TCP/IP and IPP for Printing” Configuring NetBEUI

for Printing"
{ 3. Select the appropriate software J
If using TCP/IP .. If using IPP or NetBEUI ...
Multidirect Print
4 Install the software and set the printer driver port J

"Usmg PortNavi" D "Using Multidirect Print"

Printing with a Windows 2000 or Windows NT Print Server

See P.13 “Setting up a Client Computer” for how to configure Windows 95/98 /Me
with a Windows 2000 or Windows NT print server.



Windows 95/98/Me Configuration

Configuring Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 95/98/Me to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.
* Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide that comes with this printer.

If DHCP is used to assign IP addresses, see P.104 “When Using DHCP”.

& Note

O After setting the IP address, use the ping command to confirm that it has been
set correctly.

@ Click [Start], point to [Programs], and then click [MS-DOS Prompt].

@ Type the following. (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16

If the address has been configured correctly, the following message ap-
ears.

II;eply from 192.168.15.16 : bytes=32 time<lOms TTL=32

If the address has been configured incorrectly, the following message ap-

pears.

Request timed out.

Configuring a Windows 95/98/Me computer

Follow these steps to configure a Windows 95/98 /Me computer to use the TCP/
IP protocol.

ﬂ Open [Control Panel] and double-click the [Network] icon. Confirm that “TCP/
IP” is listed in the [The following network components are installed:] box on the
[Configuration] tab.

& Note

O If the TCP/IP protocol is not installed, click [Add] on the [Configuration] tab
and install it. For more information about installing the TCP/IP protocol,
see Windows 95/98/Me Help.



Configuring Protocols

ﬂ Configure the TCP/IP protocol with the appropriate IP address, subnet
mask and other settings.

Confirm with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 95/98/Me to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.

¢ Confirm that the NetBEUI protocol is set to be active. (The factory default is
active.)

A Reference
For more information about how to make the above settings, see the Setup
Guide that comes with this printer.

Configuring a Windows 95/98/Me computer

Install the NetBEUI protocol on the Windows 95/98/Me computer and set it as
the default protocol.

ﬂ Open [Control Panel] and double-click the [Network] icon. Confirm that “Net-
BEULI” is listed in the [The following network components are installed:] box on
the [Configuration] tab.

& Note

O If the NetBEUI protocol is not installed, click [Add] on the [Configuration] tab
and install it. For more information about installing the NetBEUI protocol,
see Windows 95/98/Me Help.

O If “NetBEUI ->Dial-Up Adaptor” is listed in the [The following network com-
ponents are installed:] box, select it and click [Remove] to remove the binding.

g Set the NetBEUI protocol as the default protocol. Click the [Configuration]
tab, select “NetBEUI” in the [The following network components are installed:]
box, and click [Properties].

B Click the [Advanced] tab, select [Set this protocol to be the default protocol], and
click [OK].

ﬂ Click [OK] to close the [Network] dialog box.

B When the message to restart appears, click [Yes].




Windows 95/98/Me Configuration

Using PortNavi

PortNaviis a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

% PortNavi features
* Send a print job directly to the network printers without using a print server.
* Notification when a printing error occurs.

* Print documents using other printers in the printer group when the speci-
fied printer is busy (Recovery Printing).

ﬂlmportant

O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing.

* Printer models

¢ Installed options (e.g. Paper Tray)

* Size and orientation of paper in each paper tray
¢ Total memory

* Installed fonts (including the downloaded fonts)

¢ Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

iiklmportant

O The following must be the same for the specified printer and the print-
ers selected for Parallel Printing.

* Printer models

¢ Installed options (e.g. Paper Tray)

* Size and orientation of paper in each paper tray
¢ Total memory

* Installed fonts (including the downloaded fonts)

® Limitation

O To use PortNavi you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

O For more information about installing PRINTER MANAGER FOR CLIENT,
see the Setup Guide that comes with this printer.

& Note

O Be sure to close all applications before beginning the installation process. In-
stalling PortNavi may require the computer to be restarted.



Using PortNavi

Installing PortNavi

Follow the procedure below to install PortNavi.

ﬂ Configure the IP parameters on the Network Interface Board using the op-
eration panel.

p Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the Setup Guide that
comes with this printer.

ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note

O If the installer starts automatically, you can use it to install PortNavi. Fol-
low the instructions on the screen.

B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ On the [Install/Uninstall] tab, click [Install].
B click [Next>].

B Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “\NETWORK\PORTNAVI\DISKI\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

@ Note

O An example would be “D:\NETWORK\PORTNAVI\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

8 After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After installation is complete, configure the printer port with PortNavi. = P.7
“Setting Up the Printer Driver”

& Note

O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

ﬂ Click the [Details] tab and confirm that the PortNavi port is shown in the
[Print to the following port] box.

Remember the port name because this port should be deleted later.
El From the [Print to the following port] box, select [FILE].

O click [Apply].
The port which is currently in use is changed.

B Click [Delete Port].

E Click the PortNavi port name as confirmed in step B, then click [OK].
The port is deleted.

ﬂ Click [OK] to close the printer properties.

Uninstalling PortNavi

] Preparation
Before uninstalling PortNavi, make sure that:

¢ The PortNavi settings dialog box is closed.
* No printer is using the PortNavi port as a printer port.

I] Open [Control Panel], and double-click the [Add/Remove Programs] icon.
EI On the [Install/Uninstall] tab, click [PortNavi], and click [Add/Remove].

B After a confirmation message appears, click [Yes].
UninstallShield removes all of the components of PortNavi.

ﬂ After a confirmation message, click [Yes].
B Confirm the [Remove Shared Files?] dialog box.

B When the uninstallation is complete, click [OK].



Using PortNavi

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

g From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Details] tab and click [Add Port].

ﬂ Click [Other], click [PortNavi] from the list and then click [OK].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

B Click the model name of the printer, and then click [OK].

@ Note

O If you want to select any printer which is not shown here, click [IP Address]
and input the IP address of the printer.

B Confirm that the PortNavi port name is shown in the [Print to the following
port] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".
The configuration is now complete.

When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure for
Notice, Parallel Printing, Recovery Printing and Notification.

A Reference
For more information about these settings, see PortNavi Help.

ﬂ Click [Start] on the taskbar, point to [Settings], and click [Printers].

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Details] tab and click [Port Settings].
The PortNavi settings dialog box appears.



Using Multidirect Print

Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the Setup
Guide that comes with this printer.

5] Preparation
Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted.

ﬂ Close all the applications that are currently running.
ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note

O If the installer starts automatically, you can use it to install Multidirect
Print. Follow the instructions on the screen.

B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ On the [Install/Uninstall] tab, click [Install].
B click [Next>].

B Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “\NETWORK\MDP\DISKI\SETUP.EXE” (do not
include the quotation marks), and then click [Finish].

& Note
O An example would be “DANETWORK\MDP\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ From the [Choose Setup Language] list, select the language you use, and then
click [OK].

8 After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After installation is complete, configure the printer port with Multidirect
Print. = P.10 “Setting Up the Printer Driver”

& Note
O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].
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Uninstalling Multidirect Print

I] Open [Control Panel], and double-click the [Add/Remove Programs] icon.
g On the [Install/Uninstall] tab, click [Multidirect Print], and click [Add/Remove].

B After a confirmation message appears, click [Yes].
UninstallShield removes all of the components of Multidirect Print.

ﬂ When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected.

E Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer drivers.

If the printer drivers have already been installed, you can proceed to the next
step.

,O Reference

For more information about installing the printer drivers, see the Setup
Guide that comes with this printer.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

ﬂ From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

8 Click the [Details] tab, and then click [Add Port].

ﬂ In the [Add Port] box, click [Other], click [Multidirect Print], and then click [OK].

The [Select Printer] dialog box appears, and the printers which can be printed
to by TCP/IP are displayed.

? Limitation

O If PRINTER MANAGER FOR CLIENT is not installed on the computer,
printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the Setup Guide that
comes with this printer.



Using Multidirect Print

ﬂ Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

O You cannot add an address partially similar to that already used. For ex-
ample, when “192.168.0.2” is already used, “192.168.0.2xx” cannot be

used. Similarly, when “192.168.0.20” is already used, “192.168.0.2” can-
not be used.

NetBEUI

© Click [NetBEUI].
A list of printers that can be printed to by the NetBEUI protocol appears.

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
network configuration page. For more information about the printing of
configuration page, see P.108 “Network Configuration Page”.

O You cannot print to printers beyond routers.

IPP

@ Click [IPP].
The IPP setting dialog box appears.

@ In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-
dress of the printer.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address typed in [Printer URL] will be set as the IPP port
name.

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note
O For more information about these settings, see Multidirect Print Help. 11
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(3 ciick [ok).

ﬂ Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and click [OK].
This completes the settings.

To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow these steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].
g Click the [Details] tab, and then click [Port Settings].
The [Port Settings] dialog box appears.
¢ For the TCP/IP protocol, you can configure Timeout Settings.
¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note
O For more information about these settings, see Multidirect Print Help.



Setting up a Client Computer

Setting up a Client Computer

This section describes the procedures for setting up a client on a network that
uses Windows 2000 Server, Windows 2000 Professional, Windows NT Server or
Windows NT Workstation as a print server.

To print from Windows 95/98/Me, you must install the printer driver and
change the printer port to the print server.

Windows 2000 or
Windows NT Print Server

S

Windows 95/98/Me

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

ﬂ Install the printer driver as a local printer.

p Reference

For more information about installing the printer driver, see the Setup
Guide that comes with this printer.

@ Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B click [Start], point to [Settings], and then click [Printers].

B Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

O Click the [Details] tab, and click [Add Port].
B Click [Network], and click [Browse].

13
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B On the network tree, double-click the name of the computer used as the
print server.

The printers attached to the network are displayed.
ﬂ Click the name of the printer you want to use, and click [OK].
B click [ok1.

g Confirm that the port name is displayed in the [Print to the following port] box,
and click [OK].



S
2. Windows 2000

Configuration

Configuring Windows 2000

Printing Without Using a Print Server

The following procedure describes how to configure Windows 2000 to use the
printer on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows NT Server, Windows NT Workstation or NetWare based print
server.

D indicates topics explained in this document

[1. Decide on the protocol to use ]
Consult your network administrator about which of the three protocols are appropriate.
TCP/IP IPP NetBEUI

{ 2. Configure the chosen protocol J

D "Configuring TCP/IP and IPP for Printing” Configuring NetBEUI

for Printing"
{ 3. Select the appropriate software J
If using TCP/IP .. If using IPP or NetBEUI ...
Multidirect Print
4 Install the software and set the printer driver port J

"Usmg PortNavi" D "Using Multidirect Print"

15
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Printing with a Standard TCP/IP Port

Standard TCP/IP port is a standard port of Windows 2000 to enable Peer-to-
Peer printing in a network environment.

For more information about Standard TCP/IP port settings, see Windows 2000
Help.

Printing with a LPR Port

See P.28 “Configuring LPR Port Printing” for how to configure a LPR port in Win-
dows 2000.

Printing with a Windows 2000 or Windows NT Print Server

See P.29 “Setting up a Client Computer” for how to configure Windows 2000 with
a Windows 2000 or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.

* Confirm that the TCP/IP protocol is set to be active. (The factory default is ac-
tive.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

,O Reference

For more information about how to make the above settings, see the Setup
Guide that comes with this printer.

If DHCP is used to assign IP addresses, see P.104 “When Using DHCP”.

& Note
O After setting the IP address, use the ping command to confirm that it has been
set correctly.

@ Click [Start], point to [Programs], point to [Accessories] and then click [Com-
mand Prompt].

® Type the following. (Example IP address is 192.168.15.16)
C:> ping 192.168.15.16
If the address has been configured correctly, the following message ap-
pears.
Reply from 192.168.15.16 : bytes=32 time<lOms TTL=32
If the address has been configured incorrectly, the following message ap-
pears.
Request timed out.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the TCP/IP
protocol.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

EI Click [Local Area Connection]. On the [File] menu, click [Properties].

17
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B Confirm that “Internet Protocol (TCP/IP)” is selected in the [Components
checked are used by this connection:] box on the [General] tab.

& Note
O If the check box of TCP/IP protocol is not selected, select the box.

O If the TCP/IP protocol is not installed, click [Install] on the [General] tab and
install it. For more information about installing the TCP/IP protocol, see
Windows 2000 Help.

ﬂ Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Confirm with the network administrator that the settings are correct.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows 2000 to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.

* Confirm that the NetBEUI protocol is set to be active. (The factory default is
active.)

/O Reference

For more information about how to make the above settings, see the Setup
Guide that comes with this printer.

Configuring a Windows 2000 computer

Follow these steps to configure a Windows 2000 computer to use the NetBEUI
protocol.

ﬂ Click [Start] on the taskbar, point to [Settings], and then click [Network and
Dial-up Connections].

EI Click [Local Area Connection]. On the [File] menu, click [Properties].

B Confirm that “NetBEUI Protocol” is selected in the [Components checked are
used by this connection:] box on the [General] tab.

& Note
O If the check box of the NetBEUI protocol is not selected, select the box.
O If the NetBEUI protocol is not installed, click [Install] on the [General] tab

and install it. For more information about installing the NetBEUI protocol,
see Windows 2000 Help.



Using PortNavi

Using PortNavi

PortNaviis a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

% PortNavi features
* Send a print job directly to the network printers without using a print server.
* Notification when a printing error occurs.

* Print documents using other printers in the printer group when the speci-
fied printer is busy (Recovery Printing).

ﬂlmportant

O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing.

* Printer models

¢ Installed options (e.g. Paper Tray)

* Size and orientation of paper in each paper tray
¢ Total memory

* Installed fonts (including the downloaded fonts)

¢ Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

iiklmportant

O The following must be the same for the specified printer and the print-
ers selected for Parallel Printing.

* Printer models

¢ Installed options (e.g. Paper Tray)

* Size and orientation of paper in each paper tray
¢ Total memory

* Installed fonts (including the downloaded fonts)

® Limitation

O To use PortNavi you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

O For more information about installing PRINTER MANAGER FOR CLIENT,
see the Setup Guide that comes with this printer.

& Note

O If you use the Multidirect Print port for printing, the port is switched auto-
matically to the PortNavi port.

O Be sure to close all applications before beginning the installation process. In-
stalling PortNavi may require the computer to be restarted.

19




20

Windows 2000 Configuration

Installing PortNavi

Follow the procedure below to install PortNavi.

ﬂ Configure the IP parameters on the Network Interface Board using the op-
eration panel.

p Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the Setup Guide that
comes with this printer.

ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note

O If the installer starts automatically, you can use it to install PortNavi. Fol-
low the instructions on the screen.

B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ Click [Add New Programs], and then click [CD or Floppy].
B click [Next>].

BType the name of the CD-ROM drive in the [Open] box, followed by
“\NETWORK\PORTNAVI\DISKI\SETUP.EXE” (do not include the
quotation marks), and then click [Finish].

& Note
O An example would be “D:\NETWORK\PORTNAVI\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ From the [Choose Setup Language] list, select the language you use, and then
click [OK].

8 After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After installation is complete, configure the printer port with PortNavi. =
P.22 “Setting Up the Printer Driver”

& Note

O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

ﬂ Click the [Ports] tab and confirm that the PortNavi port is shown in the [Print
to the following port(s)] box.

Remember the port name because this port should be deleted later.
8 Click the [FILE] check box in the [Port] column.

ﬂ Click [OK] to close the Printer Properties.
The port which is currently in use is changed.

B Open the Printer Properties of the same printer.
E Click to select the [Ports] tab.

ﬂ At the [Port] column in the [Print to the following port(s)] dialog box, click to se-
lect the PortNavi port name as confirmed in step B.

8 Click [Delete Port].

g When the confirmation message appears, click [Yes].
The port is deleted.

[m Click [Close] to close the Printer Properties.

Uninstalling PortNavi

E Preparation
Before uninstalling PortNavi, make sure that:

* The port settings dialog box is closed.
* No printer is using the PortNavi port as a printer port.

ﬂ Open [Control Panel], and double-click the [Add/Remove Programs] icon.

8 Click the [Change or Remove Programs] tab, click [PortNavi], and click [Change/
Remove].

B After a confirmation message appears, click [Yes].
UninstallShield removes all of the components of PortNavi.

2]
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ﬂ After a confirmation message appears, click [Yes].

B Confirm the [Remove Shared File?] dialog box.
E When the uninstallation is complete, click [OK].

Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

ﬂ From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

8 Click the [Ports] tab and click [Add Port].

ﬂ Click [PortNavi] in the [Available port types:] box, and then click [New Port].

The [Select Printer] dialog box appears and printers on the network are
browsed.

The displayed items are as follows:

Model Name: The model name of the printer.

Name: The name of Network Interface Board.

Comment: Additional information about Network Interface Board.
Address: The IP address of the printer.

B Click the model name of the printer, and then click [OK].

& Note

O If you want to select any printer which is not shown here, click [IP Address]
and input the IP address of the printer.

E Confirm that the PortNavi port name is shown in the [Print to the following
port(s)] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".
The configuration is now complete.

When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.



Using PortNavi

Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure No-
tice, Parallel Printing and Recovery Printing.

A Reference
For more information about these settings, see PortNavi Help.

ﬂ Click [Start] on the taskbar, point to [Settings], and click [Printers].

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab and click [Configure Port].
The PortNavi settings dialog box appears.

23
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Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the Setup
Guide that comes with this printer.

5] Preparation

Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted.

ﬂ Close all the applications that are currently running.
ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note

O If the installer starts automatically, you can use it to install Multidirect
Print. Follow the instructions on the screen.

B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ Click [Add New Programs], and then click [CD or Floppy].
B click [Next>].

BType the name of the CD-ROM drive in the [Open] box, followed by
“\NETWORK\MDP\DISKI\SETUP.EXE” (do not include the quotation
marks), and then click [Finish].

& Note
O An example would be “DANETWORK\MDP\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ From the [Choose Setup Language] list, select the language you use, and then
click [OK].

8 After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After installation is complete, configure the printer port with Multidirect
Print. = P.25 “Setting Up the Printer Driver”

& Note

O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].
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Uninstalling Multidirect Print

I] Open [Control Panel], and double-click the [Add/Remove Programs] icon.

g Click [Change or Remove Programs], click [Multidirect Print], and click [Change/
Remove].

B After a confirmation message appears, click [Yes]. g
UninstallShield removes all of the components of Multidirect Print.

ﬂ When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected.

E Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer drivers.

If the printer drivers have already been installed, you can proceed to the next
step.

,O Reference

For more information about installing the printer drivers, see the Setup
Guide that comes with this printer.

& Note
O Any port can be selected during the installation, however, LPT1 is recom-
mended.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

8 Click the [Ports] tab, and click [Add Port].

ﬂ In the [Available Printer Ports] box, click [Multidirect Print] , and then click [New
Port].

The [Add Port] dialog box appears, and the printers which can be printed to by
TCP/IP are displayed.

® Limitation

O If PRINTER MANAGER FOR CLIENT is not installed on the computer,
printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the Setup Guide that
comes with this printer.

25
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ﬂ Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
network configuration page. For more information about the printing of
configuration page, see P.108 “Network Configuration Page”.

O You cannot print to printers beyond routers.

IPP

© Click [IPP].
The IPP setting dialog box appears.

@ In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-
dress of the printer.

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note
O For more information about these setting, see Multidirect Print Help.

(3 ciicx [ox.
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ﬂ Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port(s)] box, and click [Close].

This completes the settings.

To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow the steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].
g Click the [Ports] tab, and then click [Configure Port].
The [Port Settings] dialog box appears
e For TCP/IP protocol, you can configure Timeout Settings.
¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note
O For more information about these settings, see Multidirect Print Help.
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Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
2000.

& Note

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocol, see P.17 “Configuring TCP/IP and
IPP for Printing”.

B ciicx [Start], point to [Settings], and then click [Printers].
The [Printers] window appears.

ﬂ Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

El In the [Available port types:] box, click “LPR Port”, and then click [New Port].

@ Note

O If “LPR Port” does not appear, “Print Services for Unix” has not been in-
stalled.

ﬂ Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd:] box.

B Type “1p” into the [Name of printer or print queue on that server box:], and click
[OK].

( click [Close].

ﬂ Confirm that the port name is displayed in the [Print to the following port(s)]
box and the check mark is inside the check box, and then click [OK].



Setting up a Client Computer

Setting up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000 Server, Windows 2000 Professional, Windows NT Server or
Windows NT Workstation as a print server.

To print from Windows 2000, you must install the printer driver and change the
printer port to the print server.

Windows 2000 or
Windows NT Print Server

V

)\
&

S

Windows 2000

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.
ﬂ Click [Start], point to [Settings], and then click [Printers].

E Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

B Click [Next >].
ﬂ Click [Network printer], and click [Next >].

B In the [Shared printers:] box, double-click the name of the computer used as
a print server.

The printers attached to the network are displayed.
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B Click the printer you want to use, and click [Next >].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

O There is a Windows 2000 printer driver on the CD-ROM that comes with
this printer.

ﬂ Select whether to use this printer as the default printer, and click [Next >].

8 After installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.



e
3. Windows NT 4.0

Configuration

Configuring Windows NT 4.0

Printing Without Using a Print Server

The following procedure describes how to configure Windows NT 4.0 to use the
printer on a network without a Windows 2000 Server, Windows 2000 Profes-
sional, Windows NT Server, Windows NT Workstation or NetWare based print
server.

D indicates topics explained in this document

[1. Decide on the protocol to use ]
Consult your network administrator about which of the three protocols are appropriate.
TCP/IP IPP NetBEUI

{ 2. Configure the chosen protocol J

D "Configuring TCP/IP and IPP for Printing” Configuring NetBEUI

for Printing"
{ 3. Select the appropriate software J
If using TCP/IP .. If using IPP or NetBEUI ...
Multidirect Print
4 Install the software and set the printer driver port J

"Usmg PortNavi" D "Using Multidirect Print"
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Printing with a LPR Port

See P.45 “Configuring LPR Port Printing” for how to configure a LPR port in Win-
dows NT 4.0.

Printing with a Windows 2000 or Windows NT Print Server

See P.46 “Setting up a Client Computer” for how to configure Windows NT 4.0
with a Windows 2000 or Windows NT print server.



Configuring the Protocols

Configuring the Protocols

Configuring TCP/IP and IPP for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows NT to use the TCP/IP protocol and IPP.

Configuring the printer

Configure the printer to use the TCP/IP protocol.
* Confirm that the TCP/IP protocol is set to be active. (The factory default is active.)

* Assign an IP address and make other settings required for using the TCP/IP
protocol.

/O Reference

For more information about how to make the above settings, see the Setup
Guide that comes with this printer.

If DHCP is used to assign IP addresses, see P.104 “When Using DHCP”.

& Note

O After setting the IP address, use the ping command to confirm that it has been
set correctly.

@ Click [Start], point to [Programs], and then click [Command Prompt].

@ Type the following. (Example IP address is 192.168.15.16)

C:> ping 192.168.15.16

If the address has been configured correctly, the following message ap-
ears.

II;eply from 192.168.15.16 : bytes=32 time<lOms TTL=32

If the address has been configured incorrectly, the following message ap-

pears.

Request timed out.

Configuring a Windows NT computer

Follow these steps to configure a Windows NT computer to use the TCP/IP pro-
tocol.

ﬂ Open [Control Panel] and double-click the [Network] icon. Confirm that “TCP/
IP Protocol” is listed in the [Network protocols] box on the [Protocols] tab.

& Note

O If the TCP/IP protocol is not installed, click [Add] on the [Protocols] tab and
install it. For more information about installing the TCP/IP protocol, see
Windows NT Help.
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ﬂ Configure the TCP/IP protocols with the appropriate IP address, subnet
mask and other settings.

Confirm with the network administrator that the settings are correct.

B Click the [Services] tab, and confirm that “Microsoft TCP/IP Printing” is in-
stalled.

If “Microsoft TCP/IP Printing” is not installed, click [Add] on the [Services]
tab, and install it. For more information about installing and configuring net-
work services, see Windows NT Help.

Configuring NetBEUI for Printing

Follow these instructions to configure the Network Interface Board and Win-
dows NT to use the NetBEUI protocol.

Configuring the printer

Configure the printer to use the NetBEUI protocol.

¢ Confirm that the NetBEUI protocol is set to be active. (The factory default is
active.)

p Reference

For more information about how to make the above settings, see the Setup
Guide that comes with this printer.

Configuring a Windows NT computer

Install the NetBEUI protocol on the Windows NT computer, and change the
LAN adapter number (Lana Number).

ﬂ Open [Control Panel] and double-click the [Network] icon. Confirm that “Net-
BEUI Protocol” is listed in the [Network Protocols] box on the [Protocols] tab.

& Note

O If the NetBEUI protocol is not installed, click [Add] on the [Protocols] tab,
and install it. For more information about installing the NetBEUI protocol,
see Windows NT Help.

g Change the Lana Number. Click the [Services] tab, click “NetBIOS Inter-
face” in the [Network Services] box , and click [Properties].

B Click the Lana Number corresponding the Nbf protocol of the [Network
Route] headline, and click [Edit].



Configuring the Protocols

ﬂ Type “0” as the Lana Number.

& Note

O If the other protocol's Lana Number is configured with “0”, you must
change the Lana Number a number other than “0”.

H crick [ox).
E Click [Close], and close the [Network] dialog box.
ﬂ After confirming the message to restart, click [Yes].

& Note
O After you change the Lana Number, you must restart the computer.
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Using PortNavi

PortNaviis a utility that helps you to use network printers effectively. It is useful
in environments where two or more network printers are used. It is recommend-
ed that you install PortNavi to use Parallel Printing and Recovery Printing. For
more information about PortNavi, see PortNavi Help.

% PortNavi features
* Send a print job directly to the network printers without using a print server.
* Notification when a printing error occurs.

* Print documents using other printers in the printer group when the speci-
fied printer is busy (Recovery Printing).

ﬂlmportant

O The following must be the same for the specified printer and the print-
ers selected for Recovery Printing.

* Printer models

¢ Installed options (e.g. Paper Tray)

* Size and orientation of paper in each paper tray
¢ Total memory

* Installed fonts (including the downloaded fonts)

¢ Equally divide the number of copies to be printed among the selected
printers in the printer group (Parallel Printing).

iiklmportant

O The following must be the same for the specified printer and the print-
ers selected for Parallel Printing.

* Printer models

¢ Installed options (e.g. Paper Tray)

* Size and orientation of paper in each paper tray
¢ Total memory

* Installed fonts (including the downloaded fonts)

® Limitation

O To use PortNavi you must install PRINTER MANAGER FOR CLIENT and
use the TCP/IP protocol. For the name of the PRINTER MANAGER FOR
CLIENT you use, see the inside the front cover of this manual.

O For more information about installing PRINTER MANAGER FOR CLIENT,
see the Setup Guide that comes with this printer.

O On a computer that is used as a print server, do not use the features such as
Parallel Printing, Recovery Printing and Notify. For more information about
turning off these features, see PortNavi Help.
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& Note
O If you use the Multidirect Print port for printing, the port is switched auto-
matically to the PortNavi port.

O Be sure to close all applications before beginning the installation process. In-
stalling PortNavi may require the computer to be restarted.

Installing PortNavi

Follow the procedure below to install PortNavi.

ﬂ Configure the IP parameters on the Network Interface Board using the op-
eration panel.

p Reference

For more information about setting IP parameters, see “Configuring the
printer for the Network with the Operation Panel” in the Setup Guide that
comes with this printer.

g Insert the CD-ROM into the CD-ROM drive.

& Note

O If the installer starts automatically, you can use it to install PortNavi. Fol-
low the instructions on the screen.

El Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ On the [Install/Uninstall] tab, click [Install].
B click [Next>].

E Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “\NETWORK\PORTNAVI\DISKI\SETUP.EXE”
(do not include the quotation marks), and then click [Finish].

& Note

O An example would be “D:ANETWORK\PORTNAVI\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

8 After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After installation is complete, configure the printer port with PortNavi. =
P.39 “Setting Up the Printer Driver”

@ Note

O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].
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Deleting the port

The following procedure allows you to delete the printer port. If you want to de-
lete the port which is currently used in Windows, switch the port to another such
as "FILE", then delete it. For more information about PortNavi, see PortNavi
Help.

ﬂ From the [Printers] window, click the icon of the printer which uses Port-
Navi to print. On the [File] menu, click [Properties].

ﬂ Click the [Details] tab and confirm that the PortNavi port is shown in the
[Print to the following port] box.

Remember the port name because this port should be deleted later.
El From the [Print to the following port] box, select [FILE].

O click [Apply].
The port which is currently in use is changed.

B Click [Delete Port].

E Click the PortNavi port name as confirmed in step B, then click [OK].
The port is deleted.

ﬂ Click [OK] to close the printer properties.

Uninstalling PortNavi

] Preparation
Before uninstalling PortNavi, make sure that:

¢ The port settings dialog box is closed.
* No printer is using the PortNavi port as a printer port.

I] Open [Control Panel], and double-click the [Add/Remove Programs] icon.
EI On the [Install/Uninstall] tab, click [PortNavi], and click [Add/Remove].

B After a confirmation message appears, click [Yes].
UninstallShield removes all of the components of PortNavi.

ﬂ After a confirmation message appears, click [Yes].
B Confirm the [Remove Shared File?] dialog box.

B When the uninstallation is complete, click [OK].
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Setting Up the Printer Driver

The following procedure allows you to configure the printer port to use Port-
Navi.

5] Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer driver of the printer you want to use.

g From the [Printers] window, click the icon of the printer. On the [File] menu,
click [Properties].

B Click the [Details] tab and click [Add Port].

ﬂ Click [Other], click [PortNavi] from the list and then click [OK].
The [Select Printer] dialog box appears .
The displayed items are as follows:
Model Name: The model name of the printer.
Name: The name of the Network Interface Board.
Comment: Additional information about the Network Interface Board.
Address: The IP address of the printer.

B Click the model name of the printer, and then click [OK].

@ Note

O If you want to select any printer which is not shown here, click [IP Address]
and input the IP address of the printer.

B Confirm that the PortNavi port name is shown in the [Print to the following
port] box, and click [OK].

The PortNavi port name is shown as "IP address@model name".
The configuration is now complete.

When printing, select the configured printer here and print as usual. Printing
will be done automatically by PortNavi.
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Accessing the Port Settings Dialog Box

This section describes how to access the port settings dialog box to configure No-
tice, Parallel Printing and Recovery Printing.

A Reference
For more information about these settings, see PortNavi Help.

ﬂ Click [Start] on the taskbar, point to [Settings], and click [Printers].

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Details] tab and click [Port Settings].
The PortNavi settings dialog box appears.



Using Multidirect Print

Using Multidirect Print

Multidirect Print allows you to print to network printers with the NetBEUI pro-
tocol and IPP.

Installing Multidirect Print

Follow the procedure below to install Multidirect Print. This section assumes
that the appropriate printer driver has already been installed on the computer.
For more information about how to install the printer driver, see the Setup
Guide that comes with this printer.

5] Preparation
Be sure to close all applications before beginning the installation process. In-
stalling Multidirect Print may require the computer to be restarted.

ﬂ Close all the applications that are currently running.
ﬂ Insert the CD-ROM into the CD-ROM drive.

& Note

O If the installer starts automatically, you can use it to install Multidirect
Print. Follow the instructions on the screen.

B Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ On the [Install/Uninstall] tab, click [Install].
B click [Next>].

B Type the name of the CD-ROM drive in the [Command line for installation pro-
gram] box, followed by “\NETWORK\MDP\DISKI\SETUP.EXE” (do not
include the quotation marks), and then click [Finish].

& Note
O An example would be “DANETWORK\MDP\DISKI\SETUP.EXE”
when the drive letter is “D”.

ﬂ From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

8 After the [Welcome] dialog box appears, click [Next >].
Follow the instructions on the screen.
After installation is complete, configure the printer port with Multidirect
Print. = P.42 “Setting Up the Printer Driver”

& Note
O If the dialog box asking if you want to restart the computer appears, select
[Yes, | want to restart my computer now.].
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Uninstalling Multidirect Print

I] Open [Control Panel], and double-click the [Add/Remove Programs] icon.
g On the [Install/Uninstall] tab, click [Multidirect Print], and click [Add/Remove].

B After a confirmation message appears, click [Yes].
UninstallShield removes all of the components of Multidirect Print.

ﬂ When the uninstallation is complete, restart the computer.

Setting Up the Printer Driver

Multidirect Print cannot be used until the printer driver is installed and the cor-
rect port is selected.

E Preparation
The target printer must be turned on before starting the installation process.

ﬂ Install the printer drivers.

If the printer drivers have already been installed, you can proceed to the next
step.

,O Reference

For more information about installing the printer drivers, see the Setup
Guide that comes with this printer.

& Note
O Any port can be selected during the installation, however, LPT1 is recom-
mended.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].

8 Click the [Ports] tab, and click [Add Port].

ﬂ In the [Available Printer Ports] box, click [Multidirect Print] , and then click [New
Port].

The [Select Printer] dialog box appears, and the printers which can be printed
to by TCP/IP are displayed.

? Limitation

O If PRINTER MANAGER FOR CLIENT is not installed on the computer,
printers which can be printed to by TCP/IP are not displayed. For more in-
formation about how to install the program, see the Setup Guide that
comes with this printer.
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ﬂ Select the printer.

TCP/IP

@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an IP broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the IP address or host name.

NetBEUI

@ Click [NetBEUI].
A list of printers that can be printed by the NetBEUI protocol appears.
@ Click the printer you want to use, and then click [OK].

& Note

O Printers that respond to an broadcast from the computer will be dis-
played. To print to a printer not listed here, click [Specify Address] and
then type the NetBEUI address. Confirm the NetBEUI address on the
network configuration page. For more information about the printing of
configuration page, see P.108 “Network Configuration Page”.

O You cannot print to printers beyond routers.

IPP

© Click [IPP].
The IPP setting dialog box appears.

@ In [Printer URL], type “http://(printer's IP address)/printer” as the IP ad-
dress of the printer.

© As necessary, type the names to distinguish the printer in [IPP Port Name].
Type a name differing from those of any existing port names.

If you omit this, the address entered in [Printer URL] will be set as the IPP
port name.

(Example IP address is 192.168.15.16)
http://192.168.15.16/printer

O If using a proxy server and IPP user name, click [Detailed Settings] and
configure the necessary settings.

& Note
O For more information about these setting, see Multidirect Print Help.

(3 ciicx [ox.
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ﬂ Confirm that the specified printing port is displayed in the [Print to the fol-
lowing Port] box, and click [OK].

This completes the settings.

To print, select the printer specified here, and print in the usual manner. Mul-
tidirect Print will now direct print data to the printer automatically.

Changing Port Settings

Follow the steps to change Multidirect Print settings, such as the proxy server
settings or IPP URL.

& Note
O There are no settings for the NetBEUI protocol.

ﬂ From the [Printers] window, click the icon of the printer you want to use. On
the [File] menu, click [Properties].
g Click the [Ports] tab, and then click [Port Configuration].
The [Port Settings] dialog box appears
* For TCP/IP protocol, you can configure Timeout Settings.
¢ For IPP, you can configure User Settings, Proxy Settings and Timeout Set-
tings.

& Note
O For more information about these settings, see Multidirect Print Help.



Configuring LPR Port Printing

Configuring LPR Port Printing

This section explains the procedure for printing to a LPR port from Windows
NT.

& Note

O The following procedure assumes that the printer drivers have already been
installed. This is the procedure to change the printer port to LPR.

O The TCP/IP protocols must be installed and configured correctly. For more
information about configuring the protocol, see P.33 “Configuring TCP/IP and
IPP for Printing”.

B ciicx [Start], point to [Settings], and then click [Printers].

g Click the icon of the printer you want to use. On the [File] menu, click [Prop-
erties].

B Click the [Ports] tab, and then click [Add Port].
ﬂ In the [Available Printer Ports] box, click “LPR Port”, and then click [New Port].

& Note
O If “LPR Port” does not appear, “Microsoft TCP/IP Printing” has not been
installed.

B Type the IP address of the Network Interface Board into the [Name or address
of server providing Ipd] box.

B Type “1p” into the [Name of printer or print queue on that server] box, and click
[OK].

U click [Close].

8 Confirm that the port name is displayed in the [Print to the following port(s)]
box and the check mark is inside the check box, and then click [OK].
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Setting up a Client Computer

This section describes the procedures for setting up a client in a network that
uses Windows 2000 Server, Windows 2000 Professional, Windows NT Server or
Windows NT Workstation as a print server.

To print from Windows NT 4.0, you must install the printer driver and change
the printer port to the print server.

Windows 2000 or
Windows NT Print Server

N

Windows NT 4.0

& Note

O This section assumes that the client has already been configured to communi-
cate with a Windows 2000 or Windows NT print server. Do not begin the fol-
lowing procedure until the client has been set up and configured correctly.

Use the [Printers] window to set up the printer.
B ciicx [Start], point to [Settings], and then click [Printers].

B Double-click the [Add Printer] icon.
This launches the Add Printer Wizard.

El Click [Network printer server], and click [Next >].

ﬂ In the [Shared Printers] box, double-click the name of the computer used as a
print server.

The printers attached to the network are displayed.
B Click the printer you want to use, and click [OK].

& Note

O If the printer driver is not installed in the print server, a message appears.
If a driver has been installed on the client, click [OK], and follow the in-
structions on the screen.

O There is a Windows NT printer driver on the CD-ROM that comes with
this printer.



Setting up a Client Computer

B Select whether to use this printer as the default printer, and click [Next >].

ﬂ After installation is complete, click [Finish].
The icon of the newly installed printer appears in the [Printers] window.
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e
4. NetWare Configuration

This chapter describes how to configure the printer to use as a print server or a
remote printer in a NetWare environment.

& Note

O NetWare must be set to active using the operation panel of the printer. For
more information about how to set it, see the Setup Guide that comes with
this printer.

Installing the NIB Setup Tool

A utility called the NIB Setup Tool is provided to configure the printer to work
in a network environment. This section describes how to install PRINTER MAN-
AGER FOR ADMINISTRATOR, and how to run the NIB Setup Tool.

® Limitation

O The NIB Setup Tool is supported to work with the following operating sys-
tems.

e Microsoft Windows 95/98/Me
¢ Microsoft Windows 2000
e Microsoft Windows NT 4.0

Installing PRINTER MANAGER FOR ADMINISTRATOR

Follow these steps to install PRINTER MANAGER FOR ADMINISTRATOR.

E Preparation

You should install PRINTER MANAGER FOR ADMINISTRATOR on the
computer. If you install PRINTER MANAGER FOR ADMINISTRATOR from
a file server or run it via the network, PRINTER MANAGER FOR ADMINIS-
TRATOR might not work correctly.

Be sure to close all applications before starting the installation procedure.
ﬂ Close all the applications that are currently running.

ﬂ Insert the CD-ROM labeled “Printer Drivers and Utilities” into the CD-
ROM drive.

If the installer starts automatically, follow the instructions on the screen.
If not, go to step B.

8 Open [Control Panel], and double-click the [Add/Remove Programs] icon.
ﬂ On the [Install/Uninstall] tab, click [Install].
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B click [Next>].

E In the [command line for installation program] box, type the name of the CD-ROM
drive followed by “\NETWORK\PRINTMAN\ADMIN\DISKI\SETUP.EXE”
(do not include the quotation marks) and then click [Finish].

& Note
O An example would be “D:\NETWORK\PRINTMAN\ADMIN\DISK1\SET-
UP.EXE” when the CD-ROM drive name is “D”.

ﬂ From the [Choose Setup Language] list, select the language you want to use,
and then click [OK].

8 After the [Welcome] dialog box appears, click [Next >].

g The [Software License Agreement] dialog box appears.

After reading through all of the contents by clicking [PageDown], click [Yes] to
agree with the License Agreement.

[m Select a folder to install PRINTER MANAGER FOR ADMINISTRATOR
in, and then click [Next >].

If you want to change the displayed folder, click [Browse] to select another
one.

The installation program starts.

When a confirmation dialog box appears, the installation program is com-
plete.

Running the NIB Setup Tool

ﬂ Click [Start], point to [Programs], and then click [NIB Setup Tool] in the [PRINT-
ER MANAGER FOR ADMINISTRATOR] program folder.



Quick Setup Using the NIB Setup Tool Wizard

Quick Setup Using the NIB Setup Tool
Wizard

Using the NIB Setup Tool, you can easily set up a NetWare printing environ-
ment.

p Reference

For more information about installing the NIB Setup Tool, see P.49 “Installing
the NIB Setup Tool”.

You can select [Wizard] or [Property Sheet] as an installation method.

When you configure the Network Interface Board for the first time, use the Wiz-
ard method.

If you want to use the Property Sheet method, see P.54 “NetWare 3.x - Advanced
Settings” or P.60 “NetWare 4.x, 5 - Advanced Settings”.

& Note

O This section assumes that NetWare is functional and that the necessary envi-
ronment for NetWare Print Services is available.

O If you configure the Network Interface Board in a NetWare environment us-
ing the NIB Setup Tool, you should install the client software released from
Novell in the following cases.

* Windows 95/98/Me in NDS mode configuration
¢ Windows 2000 in NDS mode configuration

* Windows 2000 in Bindery mode configuration

e Windows NT 4.0 in NDS mode configuration

¢ Windows NT 4.0 in Bindery mode configuration

ﬂ Log on to the Netware file server or the NDS tree as an Admin or Admin
equivalent.

ﬂ Run the NIB Setup Tool.

A Reference
= P.50 “Running the NIB Setup Tool”

B click [wizard] and click [OK].
The [Network board list] dialog box of the Network Interface Board appears.

O click [IPX protocol].
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ﬂ Click to select the IPX address of the Network Interface Board you are con-
figuring, and click [Next >].

& Note
O If you do not know which Network Interface Board you are configuring,

see a network configuration page to confirm the MAC address (Network
address).

B Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].
ﬂ Type the print server name into the [Device Name] box, and click [Next >].

The default setting is “RDP_" followed by the 6 digit serial number. We rec-
ommend that you change it to something that is easier to remember or some-
thing based on the structure of the network.

8 In a dialog box for selecting a network environment, click to select the [Net-
Ware] check box and click to clear the [TCP/IP] check box.

B Click [Next >.
A dialog box for configuring the NetWare environment appears.

[[D Select [Bindery] when printing under Bindery mode, or select [NDS] when
printing under NDS mode.

When you are using NetWare version 4.x, you should select [NDS].

ﬂ] If you selected [Bindery], type into the [File Server Name:] box the name of the
file server in which a print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

[ﬂ If you selected [NDS], type into the [Tree:] box the name of the NDS tree in
which the print server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among those
listed in the [Browse] dialog boxes.

As a context, object names are typed from a lower object and divided by a pe-
riod. For example, if you want to create a print server into NET under DS,
type “NET.DS”.

[B Click [Next >].
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[[I Type the name of the printer into the [Printer Name] box, and the name of the
print queue into the [Print Queue Name] box.

The default setting for Printer Name is “Print Server Name” followed by “_1"
and that for Print Queue Name is “Print Server Name” followed by “_Q”
(quotation marks are not included). You can change them if necessary.

[B If you have selected NDS mode, type the volume of the print queue into the
[Queue Volume] box.

Clicking [Browse], you can select one of those shown in the [Browse] dialog
box.

0 Click [Next>].
A dialog box to confirm the printing environment appears.

[ﬂ After confirming the environment, click [Next >].
If you want to change the settings, click [< Back] and make the settings again.

Clicking [Next >], the NIB Setup Tool automatically creates the Print Server,
the Printer, and the Print Queue in the NetWare network.

[B After a confirmation dialog box appears, select [Quit] and click [Finish] to
exit the NIB Setup Tool.
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NetWare 3.x - Advanced Settings

The actual procedures for configuring the printer differ depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 3.x environment.

Basic Procedure

(Install the NIB Setup Tool |

Print Server Remote Printer

(Configure the Network Interface Board )

(Configure the NetWare )

Turn the power Start the print server

off and on

] Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. = P.51 “Quick Setup Using the NIB Setup Tool Wizard”

& Note
O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

Setting Up as a Print Server

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
g Run the NIB Setup Tool.

A Reference
= P.50 “Running the NIB Setup Tool”

E] Click [Property Sheet] and click [OK].
The [Browse] dialog box of the Network Interface Board appears.

O click [IPX protocol].
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B Click the IPX address of the Network Interface Board which is to be config-
ured, and then click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,

see a network configuration page to confirm the MAC address (Network
Address).

B Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

8 Click the [General] tab, and type the name of the print server into the [Device
Name] box.

g Click the [NetWare] tab, and make the following settings.
@ Select [Bindery].

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Click [Browse] to select a file server among those listed in the [Browse] dia-
log box.

© Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

ﬂ] Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

[ﬂ Create a print queue as follows.

& Note
O If you use a currently defined print queue, go to step B.

@ From the [Available Options] menu, select [Print Queue Information] and press
the [ENTER] key.

@ Press the [INSERT) key and type a print queue name.
© Press the [ESC] key to return to the [Available Options] menu.
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[B Create a printer as follows.

@ From the [Available Options] menu, select [Print Server Information] and press
the [ENTER] key.

@ To create a new print server, press the [INSERT] key and type a print
server name.

If you use a currently defined print server, select one of the print servers
shown in the [Print Server] list.

i@klmportant
O Use the same name as that specified in the NIB Setup Tool. (Step B).
© From the [Print Server Information] menu, select [Print Server Configuration].
O From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.
O 1f you want to change the name of the printer, type a new name.
A name "Printer x" is assigned to the printer. “x” stands for the number of
the selected printer.
@ As Type, select [Remote Other/Unkown].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to the [Print Server Configuration] menu.

ﬂ] Assign print queues to the created printer as follows.
@ From the [Print Server Configuration] menu, select [Queues Serviced By Printer].
@ Select the printer created in step [B.
© Press the [INSERT] key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.

When you have finished the previous steps, confirm that the queues are as-
signed.

[B Press the [ESC] key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

[ﬁ Turn the printer power off and on.

& Note

O To confirm that the printer is configured correctly, type as follows from the
command prompt.

F:> USERLIST

O If the printer works as configured, the name of the print server appears as
an attached user.
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Setting Up as a Remote Printer

ﬂ Log on to the file server as a Supervisor or a Supervisor equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
= P.50 “Running the NIB Setup Tool”

E) Click [Property Sheet] and click [OK].
The [Browse] dialog box of the Network Interface Board appears.

O click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

& Note
O If you do not know which Network Interface Board you are configuring,

see a network configuration page to confirm the MAC address (Network
Address).

B Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

8 Click the [General] tab, and type the name of the print server into the [Device
Name] box.

g Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name] box, type the name of the print server.

@ In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.

© In the [Print Server Operation Mode] group, click [As Remote Printer].
O In the [Remote Printer No.] box, type the printer number.

FEimportant
O Use the same printer number as that to be created in the printer server.

@ Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].
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[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.

m Type “PCONSOLE” from the command prompt.
F:> PCONSOLE

[ﬂ Create a print queue as follows.

& Note
O If you use a currently defined print queue, go to step B.

@ From the [Available Options] menu, select [Print Queue Information] and press
the [ENTER] key.

@ Press the [INSERT) key and type a print queue name.
© Press the [ESC] key to return to the [Available Options] menu.

[B Create a printer as follows.

@ From the [Available Options] menu, select [Print Server Information] and press
the [ENTER] key.

@ To create a new print server, press the [INSERT] key and type a print
server name.

If you use an currently defined print server, select one of the print servers
shown in the [Print Server] list.

i@klmportant
O Use the same name as that specified in the NIB Setup Tool. (Step B).

©® From the [Print Server Information] menu, select [Print Server Configuration].
O From the [Print Server Configuration] menu, select [Printer Configuration].
@ Select the printer which is indicated as “Not Installed”.

i@klmportant
O Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step B-@).
O 1f you change the name of the printer, type a new name.

A name "Printer x" is assigned to the printer. x stands for the number of the
selected printer.

@ As type, select [Remote Parallel, LPT1].

The IRQ, Buffer size, Starting form, and Queue service mode are automat-
ically configured.

@ Press the [ESC] key, and click [Yes] in the confirmation dialog box.
© Press the [ESC] key to return to [Print Server Configuration Menul].
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[[I Assign print queues to the created printer as follows.
@ From [Print Server Configuration Menu], select [Queues Serviced By Printer].
@ Select the printer created in step {B.
© Press the [INSERT]) key to select a queue serviced by the printer.

& Note
O You can select more than one queue at a time.

O Follow the instructions on the screen to make other necessary settings.

When you have finished the above steps, confirm that the queues are as-
signed.

iE Press the [ESC] key until “Exit?” appears, and select [Yes] to exit PCON-
SOLE.

[E Start the print server by typing the following from the console of the Net-
Ware Server.

If it is running, restart it after exiting it.
% To exit

CAREE: unload pserver
% To start

CAREE: load pserver print server name

& Note
O If the printer works as configured, “Waiting for job” appears.
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NetWare 4.x, 5 - Advanced Settings

The actual procedures for configuring the printer differ depending on whether
the Network Interface Board is configured as a print server or as a remote print-
er. This section describes how to configure it in the NetWare 4.x, 5 environment.

< To use NetWare 5
* You cannot use the NDPS (Novell Distributed Print Services) mode.

¢ If you use Pure IP, configure the printer to use the TCP/IP protocol. For
more information about how to make the settings, see the Setup Guide that
comes with this printer.

Basic Procedure

(Install the NIB Setup Tool |

Print Server Remote Printer

(Configure the Network Interface Board )

(Configure the NetWare )

Turn the power Start the print server

off and on

] Preparation
The following procedures use the Property Sheet method in configuring the
Network Interface Board. If you configure the Network Interface Board as a
NetWare print server for the first time, we recommend you use the Wizard
method. = P.51 “Quick Setup Using the NIB Setup Tool Wizard”

& Note
O This section assumes NetWare is functional and that the necessary environ-
ment for the NetWare Print Service is available.

O You should install the client software released from Novell on the Windows
before running the NIB Setup Tool for configuring in NDS mode or using
Windows NT 4.0.
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Setting Up as a Print Server

iﬁklmportant

O You can set up the print server using the NDS or Bindery mode in NetWare
4.x, 5. The following procedure is for setting up the print server using the
NDS mode in NetWare 4.1. When you set up the print server using the Bind-
ery mode, use the NIB Setup Tool Wizard. = P.51 “Quick Setup Using the NIB
Setup Tool Wizard”.

& Note

O If you use Pure IP in NetWare 5, follow the procedure on P.63 “Using Pure IP
in the NetWare 5 environment”.

ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
= P.50 “Running the NIB Setup Tool”

E) Click [Property Sheet] and click [OK].
The [Browse] dialog box of the Network Interface Board appears.

O click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see a network configuration page to confirm the MAC address (Network
Address).

E Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].

The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

8 Click the [General] tab, and type the name of the print server into the [Device
Name] box.
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g Click the [NetWare] tab, and make the following settings.
@ Select [NDS].

@ Type into the [Tree:] box the name of the NDS tree in which the print
server is created, and type the context into the [Context:] box.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

© Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].

[[D On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
ﬂ] From Windows, run NWAdmin.

p Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

[B Create a print queue as follows.

@ Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

@ In the [Class of new object] box, click “Print Queue”, and click [OK].
© In the [Print Queue name] box, type the name of the print queue.
O 1n the [Print Queue Volume] box, click the [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

O After confirming the settings, click [Create].

[B Create a printer as follows.

@ Select the container object the printer is located in, and click [Create] on
the [Object] menu.

@ In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5, click “Printer (Non NDPS)”.

© In the [Printer name] box, type the name of the printer.
O Click [Define additional properties] to check a box, and click [Create].
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[[I Assign print queues to the created printer as follows.
@ Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in step B, and click
[OK].

© Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication].

O Click [Manual load] in the [Communication type] group, and click [OK].
@ After confirming the settings, click [OK].

iE Create a print server as follows.

@ Select the context specified using the NIB Setup Tool (step B-@), and on
the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5, click “Print Server (Non NDPS)”.

© In the [Print Server name] box, type the name of the print server.

ﬂlmportant
O Use the same name as that specified using the NIB Setup Tool. (Step B)

O Click [Define additional properties] to check a box, and click [Create].

[E Assign the printer to the created print server as follows.
@ Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the printer created in step B, and click
[OK].

© After confirming the settings, click [OK].

m Turn the printer power off and on.

& Note

O If the printer works as configured, the name of the print server appears as
an attached user.

Using Pure IP in the NetWare 5 environment

ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
= P.50 “Running the NIB Setup Tool”

E) Click [Property Sheet] and click [OK].
The [Network board list] dialog box appears.
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O click [TCPAP protocol].

ﬂ Click the IP address of the Network Interface Board which is to be config-
ured, and click [Next >].

& Note

O If you do not know which Network Interface Board you are configuring,
see a network configuration page to confirm the MAC address (Network
Address).

E Confirm that the MAC address and IP address are correct, and click [Finish].
The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

8 Click the [General] tab, and type the name of the print server into the [Device
Name:] box.

g Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name:] box, type the name of the print server.

@ In the [File Server Name:] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse File Server] dialog box.

© In the [NDS Context:] box, type the context of the print server.

Clicking [Browse], you can select a NDS tree and a NDS context among
those listed in the [Browse Context] dialog box.

As a context, object names are typed from a lower object and divided by a
period. For example, if you want to create a print server into NET under
DS, type "NET.DS".

O In the [Print Server Operation Mode] group, click [As Print Server].
@ Click [OK] to close the property sheet.
O After a confirmation dialog box appears, click [OK].

m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
After this step, go to step Il on P.61 “Setting Up as a Print Server”.
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Setting Up as a Remote Printer

ﬂ Log on to the file server as an Admin or an Admin equivalent.
ﬂ Run the NIB Setup Tool.

A Reference
= P.50 “Running the NIB Setup Tool”

E) Click [Property Sheet] and click [OK].
The [Browse] dialog box of the Network Interface Board appears.

O click [IPX protocol].

B Click the IPX address of the Network Interface Board which is to be config-
ured, and click [Next >].

@ Note

O If you do not know which Network Interface Board you are configuring,
see a network configuration page to confirm the MAC address (Network
Address).

B Confirm that the MAC address and IPX address are correct, and click [Fin-
ish].
The [NIB Setup Tool] window appears.

ﬂ Click [Configure].
The property sheet appears.

8 Click the [General] tab, and type the name of the print server into the [Device
Name] box.

g Click the [NetWare] tab, and make the following settings.
@ In the [Print Server Name] box, type the name of the print server.

@ In the [File Server Name] box, type the name of the file server in which a
print server is to be created.

Clicking [Browse], you can select a file server among those listed in the
[Browse] dialog box.
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© In the [NDS Context] box, type the context in which the print server is to
be created.

Clicking [Browse], you can select a context among those listed in the
[Browse] dialog box.

As an context, object names are typed from a lower level object and divid-
ed by a period. For example, if you want to create a print server into NET
under DS, type “NET.DS”.

O In the [Print Server Operation Mode] group, click [As Remote Printer].
@ In the [Remote Printer No.] box, type the number of the printer.

FEmportant
O Use the same number as that of the printer to be created in the print
server.

O Click [OK] to close the property sheet.
@ After a confirmation dialog box appears, click [OK].

[m On the [NIB] menu, click [Exit] to exit the NIB Setup Tool.
m From Windows, run NW Admin.

p Reference

For more information about NWAdmin, see the documentation that comes
with the NetWare.

[ﬂ Create a print queue as follows.

@ Select the container object the print queue is located in among those in
the directory tree, and click [Create] on the [Object] menu.

@ In the [Class of new object] box, click “Print Queue”, and click [OK].
© In the [Print Queue name] box, type the name of the print queue.
O In the [Print Queue Volume] box, click [Browse] button.

@ In the [Available objects] box, click the volume in which the print queue is
created, and click [OK].

O After confirming the settings, click [Create].

[B Create a printer as follows.

@ Select the container object the printer is located in, and click [Create] in
the [Object] menu.
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@ In the [Class of new object] box, click “Printer”, and click [OK]. When you
are using NetWare 5, click “Printer (Non NDPS)”.

© In the [Printer name] box, type the name of the printer.
O Click [Define additional properties] to check a box, and click [Create].

ﬂ] Assign print queues to the created printer as follows.
@ Click [Assignments], and click [Add] in the [Assignments] group.
@ In the [Available objects] box, click the queue created in step B, and click [OK].

© Click [Configuration], and in the [Printer type] box, select [Parallel] using the
drop-down menu, and then click [Communication].

O Click [Manual load] in the [Communication type] group, and click [OK].
@ After confirming the settings, click [OK].

[B Create a print server as follows.

@ Select the context specified using the NIB Setup Tool (Step E-@), and on
the [Object] menu, click [Create].

@ In the [Class of new object] box, click “Print Server”, and click [OK]. When
you are using NetWare 5, click “Print Sever (Non NDPS)”.

© In the [Print Server name] box, type the name of the print server.

iiklmportant
O Use the same name as that specified using the NIB Setup Tool. (Step B).

O Click [Define additional properties] to check a box, and click [Create].

[ﬁ Assign the printer to the created print server as follows.
@ Click [Assignments], and click [Add] in the [Assignments] group.

@ In the [Available objects] box, click the queue created in the step B, and
click [OK].

© In the [Printers] group, click the printer assigned in step @ , and click
[Printer Number].

O Type the printer number and click [OK].

i@klmportant
O Use the same number as that specified as Remote Printer No. using the

NIB Setup Tool. (Step B-@).
@ After confirming the settings, click [OK].
[ﬂ Start the print server by typing the following from the console of the Net-
Ware Server.
If it is running, restart it after exiting it.

% To exit
CAREE: unload pserver

% To start
CAREE: load pserver print server name
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Setting Up a Client Computer

This section describes how to set up a client computer when using a NetWare
print server.

& Note

O This section assumes that the client has NetWare client applications installed
and is correctly configured to communicate with a NetWare print server. If
not, install the necessary applications before starting the setting up proce-
dure.

Windows 95/98/Me

Follow the procedure to set up a Windows 95/98/Me client.

] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Install the printer driver you want to use as “Local printer”.

A Reference
For more information about installing the printer driver, see the Setup
Guide that comes with this printer.

& Note

O Any port can be selected during the installation, however, LPT1 is recom-
mended.

B Click [Start], point to [Settings], and then click [Printers].

B In the [Printers] window, click the icon of the printer you want to use.
O On the [File] menu, click [Properties].

B click the [Details] tab, and click [Add Port].

(3 click [Network] and click [Browse].

ﬂ On the network tree, double-click the name of the file server.

The queues are displayed.
8 Click the queue you want to print, and click [OK].

B click [ok).
In the [Print to the following port] box, a network path to the printer appears.

[m Click [OK] to close the Printer Properties, and again, open it.
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@ Click the [Printer Settings] tab.
[B Click to clear the [Form feed] and [Enable banner] check boxes.

& Note

O You should not check these boxes because they should be specified using
the printer driver. If they are selected, the printer might not print correctly.

When using the PostScript printer driver

Follow these steps to set up for the PostScript printer driver.
@ Click the [PostScript] tab.
@ Click [Advanced].

@ Click to clear the [Send CTRL+D before job] and [Send CTRL+D after job] check
boxes.

[B Click [OK] to close the Printer Properties.

Windows 2000

Follow the procedure to set up a Windows 2000 client.

] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [My Network Places] icon on the desktop and navigate to the
queue you want to use, and then double-click it.

The printers dialog box appears.
B click [No).
8 Close all the applications that are currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide that comes with this printer.

B The [Printer Installation] dialog box appears.
E From the [Port] list, select the queue you selected in step @), and click [Next >].

ﬂ Follow the instructions on the screen to finish the installation of the printer
driver.
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Windows NT 4.0

Follow the procedure to set up a Windows NT 4.0 client.

5] Preparation
Log on to the NetWare file server before starting the following procedure.

ﬂ Double-click the [Network Neighborhood] icon on the desktop and navigate to
the queue you want to use, and then double-click it.

The [Printers] dialog box appears.
B click (Nol.
B Close all the applications that are currently running.

ﬂ Insert the CD-ROM into the CD-ROM drive.

If the setup menu starts automatically, you can go to the next step. If not, see
the Setup Guide that comes with this printer.

B The [Printer Installation] dialog box appears.
B From the [Port] list, select the queue you selected in step @, and click [Next >].

ﬂ Follow the instructions on the screen to finish the installation of the printer
driver.



e
5. Macintosh Configuration

Configuring Macintosh

This section describes how to configure a Macintosh computer to use EtherTalk.
The actual procedures to configure a Macintosh may differ depending on the
version of the Mac OS. The following procedure describes how to configure Mac
OS 8. If you are not using Mac OS 8, see the manual that comes with your version
of the Mac OS for more information.

Basic Procedure

Change to EtherTalk J

(
( Configure the printer )
(

Change the printer name]

Change the zone

? Limitation

O To print from a Macintosh, use RICOH-SCRIPT2. You cannot print with
IPDL-C.

Changing to EtherTalk

Follow the procedure to configure a Macintosh computer to use EtherTalk.

A Reference
For more information about installing the software required for EtherTalk,
see the Macintosh manuals.

ﬂ Open [Control Panel], and double-click the [AppleTalk] icon.

ﬂ From the [Connect via:] pop-up menu, select “Ethernet”.

B If you change zones, select a name from the [Current zone:] pop-up menu.
ﬂ Close the [AppleTalk] control panels.

B Restart the Macintosh.
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Configuring the Printer

Use the operation panel to activate the EtherTalk protocol. (The factory default
is active.)

p Reference

For more information about configuration, see the Setup Guide that comes
with this printer.

Changing the Printer Name

If the network has several same model printers, the names will be the same.
Printers that have the same name will have their names changed slightly in the
Chooser. For example, three printers named “printer” will appear in the chooser
as “printer0”, “printerl” and “printer2”.

Use applications such as Apple Printer Utility or LaserWriter Utility to change
printer names in the Macintosh EtherTalk environment. These utilities are dis-
tributed by Apple Computer, Inc.

Changing the Zone

It may be necessary to change the zone configuration.

Use applications such as Apple Printer Utility or LaserWriter Utility to change
the zone configuration in the Macintosh EtherTalk environment. These utilities
are distributed by Apple Computer, Inc.

& Note

O If the Macintosh is configured to use TCP/IP, you can change the zone con-
figuration with a Web Browser. = P.75 “Configuring the Network Interface
Board with a Web Browser”

Follow these steps to use the Apple Printer Utility.
@ Insert the CD-ROM into the CD-ROM drive.
@ Copy the “Zone Name.ps” file in the “Zone Name” folder to the hard disk.

® Open the copied “Zone Name ps” file using a text editor, and change “New-
Zone” , which is in the second line from the bottom, to the name of the new
zone.
%!PS-Adobe2.0 %%
Title: Changing Zone (EtherNet only)
%%CreationDate: Tue Dec 16 1997
% %EndComments
true 0 startjob not {ERROR}if
(%EtherTalk%) << /EtherTalkZone (NewZone) >> setdevparams
% %EOF

@ Save “Zone Name.ps”.
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® Run the Apple Printer Utility, and select the printer for which the new zone
name is to be used.

® Select [Send PostScript File] in the [Utilities] menu, and send “Zone Name.ps” to
the printer.
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L
6. Appendix

Configuring the Network Interface Board
with a Web Browser

The Network Interface Board functions as a Web server in addition to allowing
a printer to function as a network printer. You can use a Web Browser to view
the printer status and configure the Network Interface Board.

« Configuring the printer
This requires the TCP/IP protocol to be installed. After the printer has been
configured to use the TCP/IP protocol, it will be possible to adjust the settings
using a Web Browser.

A Reference
For more information about configuring the printer to use the TCP/IP pro-
tocol, see the Setup Guide that comes with this printer.

< Operating system browser requirements

(O] Browser
Windows 95/98/Me
Windows 2000
Windows NT 4.0
Mac 0OS7.6.1~9.0

Solaris 2.5 ~ 2.6

? Limitation

O Sometimes after clicking [Back] , the previous page may not appear. In this
case, click [Refresh] or [Reload] .

O The text on the screen may disappear or be aligned incorrectly if the font
size settings of the browser are too large. It is recommended that you use
a font size equal to or smaller than “10 point” with Netscape Navigator,
and “Medium” or smaller with Internet Explorer.

Microsoft Internet Explorer 3.02/4.0 or later

Netscape Navigator 3.0/4.0 or later
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Going to the Top Page

After launching the Web Browser, type the IP address of the printer. See the ex-
ample below. This example is for the English version.

http://192.168.15.16/

(In this example, the IP address of the Network Interface Board is 192.168.15.16.)

& Note

O If a DNS server is used on the network, you can type the host name as an URL.
For example, http:/ /webmonitor.netprinter.com/. In order to do this, you
must register the IP address and host name of the Network Interface Board
with the DNS server. Consult the network administrator for information

about how to do this.

O If the network uses proxy servers, the browser may run slowly.

| URL [ Help

Status

piner Meme: Nt Printer
cammens < ['1fth Floor
Ready

1. Header Buttons

You can register favorite URLs with
[URL]. To view the Help section, click
[Help].

iﬁklmportant
O It costs to use the browser to access
a website.

& Note

O Help is stored in the following folder
on the CD-ROM in HTML format. The
third folder, "(Language)" may be sub-
stituted by an appropriate language
name.

\HELP\WSMHLP\ (Language) \

2. Menu Buttons

Buttons to configure the Network Inter-
face Board and confirm the status of the
printer.

& Note

O When you click [Network Config], a dia-
log box appears requesting the user
name and password. Type only the
password in this dialog box. The fac-
tory default password is “password”.

O The password is the same as that used
for remote maintenance and that used
in the NIB Setup Tool. If you change a
password with the Web Browser, the
other passwords are also changed.

3. Status

Displays the name and comments of the
Network Interface Board, and the printer
status.
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iQ'f‘Linking the address (URL) to the [Help] button

You can link the address (URL) of the [Help] button to the Help files on the com-
puter or on a Web server.

@ Copy the Help files on the CD-ROM to the desired location. The Help files are
located in folders labeled with abbreviated language names. For example, En-
glish Help files are in the [EN] folder. Be sure to copy the entire [EN] folder to
the new location.

® Using a Web Browser, navigate to the Top Page and click [Network config].
® Type your password, (it is not necessary to type a user name) and click [OK].

@ Type the path to the Help files in the [Help URL] box.
If you copied the Help files to "C:\HELP\EN", type "file:/ /C:/HELP/". For
example if you copied the files to a web server and the index URL is "http://
a.b.c.d/HELP/EN/index.html", type "http://a.b.c.d/HELP/".

® Click [Apply].
When a warning message appears, select to continue configuration.
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Assigning IP Address with ARP+PING

Using TCP/IP, you can assign the IP address using ARP and PING. The follow-
ing example is for a BSD UNIX workstation (SunOS 4.x).

] Preparation
ARP+PING should be set to active on the network boot configuration before
assigning the IP address using ARP+PING. For more information about set-
ting it to active, see the Setup Guide that comes with this printer.

ﬂ Log on to the workstation as root.

g Use the arp command to assign the IP address to the MAC address of the
Network Interface Board.

# arp -s 192.168.15.16 00:00:74:62:5C:65

& Note
O 192.168.15.16 is the IP address, 00:00:74:62:5C:65 is the MAC address.

8 Assign the IP address using the ping command.
# ping 192.168.15.16

ﬂ Use the ping command again to confirm the address.
# ping 192.168.15.16
If the address has been configured correctly, the following message appears.
192.168.15.16 is alive

If the address has been configured incorrectly, the following message ap-
pears.

no answer from 192.168.15.16

$How to Confirm the MAC Address

The MAC address (Ethernet address) of the Network Interface Board is required
in order to use ARP and PING to assign the IP address.

The MAC address can be seen on the network configuration page.

p Reference

For how to print the network configuration page, see P.108 “Network Config-
uration Page”.

& Note

O The MAC address can also be seen on the printer configuration page. For
more information about the printer configuration page, see the Setup Guide
that comes with this printer.
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Remote Maintenance by telnet

You can view the printer status and configure the Network Interface Board us-
ing telnet.

& Note

O You should specify a password so that only the network administrator, or a
person having network administrator privileges, can use remote mainte-
nance.

Using telnet

The following is a sample procedure in using telnet.

? Limitation

O Only one person at a time can be logged on to do remote maintenance.

ﬂ Using the IP address or host name of the printer, start telnet.

% telnet IP address

& Note
O In order to use the host name instead of the IP address, you must write it
to the /etc/hosts file.

g Type the password.

& Note
O The factory default is “password”.

8 Type a command.

pe Reference
For more information about telnet commands, see P.80 “Commands List”.

ﬂ Exit telnet.
msh> logout
When the configuration is changed, a confirmation message requests whether
or not the changes should be saved.

8 Type “yes” to save the changes, and press the [ENTER] key.

If you do not want to save the changes, type “no”and press the [ENTER] key.
If you want to make additional changes, type “return” at the command line,
and press the [ENTER] key.
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@ Note

O If the “Can not write NVRAM information” message appears, the changes
are not saved. Repeat the steps above.

O The Network Interface Board is reset automatically when the settings are
changed.

O When the Network Interface Board is reset, the active print job which has
already been sent to the printer will finish printing. However, jobs that
have not been sent yet will be canceled.

Commands List

This is a list of commands that can be used via remote maintenance.

& Note
O Type “help” to see a list of commands that can be used.

msh> help

O Type “help command_name” to display information about the syntax of that
command.

msh> help command name

TCP/IP address

Use the ifconfig command to configure TCP/IP for the printer (IP address, sub-
net mask, broadcast address, default gateway address).

«» Reference
msh> ifconfig

< Configuration
msh> ifconfig le0 parameter address

Parameter Meaning

(no parameter) IP address

netmask subnet mask

gateway default gateway address

The following is an example for configuring an IP address of 192.168.15.16.
msh> ifconfig le0 192.168.15.16

The following is an example for configuring a subnet mask of 255.255.255.0.
msh> ifconfig le0 netmask 255.255.255.0

& Note

O This affects the configuration of the Network Interface Board of the IP ad-
dress that is used.

O To type an address using hexadecimal, prefix it by “0x”.



Remote Maintenance by telnet

’iQ'FAddress

% Subnet Mask
A number used to mathematically “mask” or hide the IP address on the net-
work by eliminating those parts of the address that are alike for all the ma-
chines on the network.

< Default Gateway Address
A gateway is a connection or interchange point that connects two networks.
A gateway address is for the router or host computer used as a gateway.

& Note
O To get the above addresses, contact your network administrator.

Access Control

Use the access command to view and configure access control.
You can also configure multiple access controls with the multi command.

< Reference
msh> access

< Configuration
msh> access parameter address

Parameter Meaning

control Access Control Address

mask Access Control Mask
& Note

O The Access Control Address and the Access Control Mask are used to limit
access to the computer used for printing by denying access to users based on

their IP address. If it is not necessary to limit access, set the Access Control
Mask to “0.0.0.0”.

O When the Access Control Address matches the masked result of the IP ad-
dress computer attempting to print, print jobs from that IP address will be ac-
cepted by the Network Interface Board.
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O For example, if you assign 192.168.15.16 as the Access Control Address of the
Network Interface Board, the IP addresses that can print are as follows. XXX
means any number from 1 to 255 is acceptable.

Access Control Mask IP addresses that can access the
printer
0. 0. 0. O XXX . XXX . XXX .XXX
255. 0. 0. O 192 . XXX .XXX.XXX
255.255. 0. O 192.168.XXX.XXX
255.255.255. 0 192.168. 15.XXX
255.255.255.255 192.168. 15. 16

« Configuration for multiple access controls
msh> access multi {on | off}
“on” means active and “off” means inactive.
msh> access {1 - 5} parameter address

& Note

O Up to 5 access controls are available. Specify the number (1 - 5) when con-
figuring some access controls. If this is not configured, the first setting is
selected.

Network Boot

Use the set command to configure the boot method.
msh> set parameter {on | off}

“on” means active and “off” means inactive.

Parameter Meaning
ping ARP+PING
tftp RARP+TFTP
bootp BOOTP
dhep DHCP

& Note

O When you use RARP+TFTP, BOOTP or DHCP, the server also needs to be
configured.

O DHCP takes precedence over all other settings.
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Protocol

Use the set command to allow/prevent remote access for each protocol.

msh> set protocol {up | down}

Protocol

appletalk
tepip
netware
netbeui
lpr

ftp

rsh
diprint
web
npmp
snmp

ipp

“up” means active and “down” means
inactive.

& Note

O If you prohibit remote access using TCP/IP and then log out, you cannot use
remote access. If this was a mistake, you can use the printer operation panel

to allow access by TCP/IP.

O When you prevent access via TCP/IP, you are also prevented from using lpr,

ftp, rsh, diprint, and web.

Printer status

The following commands can be used to get information about the current status
of the printer.

msh> command

Command Information that is displayed

status Status of printer.
Information about the print jobs.

info Information about the paper tray, output tray
and printer language of the printer.

prnlog [ID] Lists the last 10 print jobs.

netstat Information about the Network Interface
Board.

& Note

O More information about any print job is displayed when the ID number is

added after the prnlog command.
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p Reference

For more information about the meaning of the data returned with these com-
mands, see “Getting Printer Information over the Network” in the Printer
Reference included as a PDF file on the CD-ROM or P.93 “Configuring the Net-
work Interface Board”.

Network Interface Board configuration settings information

Use the show command to display the Network Interface Board configuration
settings.

msh> show [-p]

& Note

O Add “-p” to the show command to have the information displayed one screen
at a time.

p Reference

For more information about the meaning of the data returned with this com-
mand, see P.93 “Configuring the Network Interface Board” .

System log information

Use the syslog command to display information stored in the printer's system
log.
msh> syslog

p Reference

For more information about the displayed information, see P.96 “System Log
Information”.

SNMP

Use the snmp command to display and edit SNMP configuration settings such
as the community name.

& Note
O You can configure from ten SNMP access settings numbered 1-10.

O Default access settings 1 and 2 are as follows.

Number 1 2

Community name public admin

IP address 0.0.0.0 0.0.0.0

Access type read-only read-write
trap off trap off
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9
%

9
%

L)

Display

Shows the SNMP information and available protocols.
msh> snmp ?

msh> snmp [-pl [registered numberl]

& Note
O If the -p option is added, you can view the settings one by one.

O Omitting the number displays all access settings.

Community name configuration
You can set the community name of the Network Interface Board.

msh> snmp number name community name

& Note
O The community name must consist of 15 characters or less.

Access type configuration
You can select the access type from those listed below.
msh> snmp number type access type

Access type Type of access which is permitted
read Read only

write Read and write

trap User is notified of trap messages.
no All access is denied.

Protocol configuration
You should use the following command to set the protocols to active or inac-

tive. If you set a protocol to inactive, all access settings set to use that protocol
are disabled.

msh> snmp {ip | ipx} {on | off}
e “on” means active and “off” means inactive

To change the protocol of an access settings, use the following command.
However, if you disabled a protocol with the above command, making it ac-
tive here will have no effect.

msh> snmp number active {ip | ipx} {on | off}

Access configuration

You can configure an address of a host depending on the protocols used.
The Network Interface Board accepts requests only from hosts having ad-
dresses with access types of “read-only” or “read-write”. Type “0” to have the
Network Interface Board accept requests from any host without requiring a
specific type of access.

Command syntax:
msh> snmp number {ip | ipx} address
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@ Note

O To specify the TCP/IP protocol, type ip followed by a space and then the
IP address.

O To specify the IPX/SPX protocol, type ipx followed by a space and then the
IPX address followed by a decimal and then the MAC address of the Net-
work Interface Board.

The following is an example of how to configure registration number 3 with

the IP address 192.168.15.16.

msh> snmp 3 ip 192.168.15.16

The following is an example of how to configure registration number 3 with

the IPX address 7390A448, and the MAC address 00:00:74:62:5C:65.

msh> snmp 3 ipx 7390A448.000074625C65

IPP

Use the ipp command to configure the IPP settings.
< View settings
The following command displays the current IPP settings.

msh >ipp
Example output:

timeout=900 (sec)
auth basic

¢ The "timeout" setting specifies how many seconds the computer keeps try-
ing to access the network printer to send print jobs when no connection
could be made.

* The "auth" setting indicates the user authorization mode.

< IPP timeout configuration
Specify how many seconds to wait before canceling a print job if it has been

interrupted for some reason. The range of time can be changed between 30 to
65535 seconds.

msh>ipp timeout {30 -65535}

< IPP user authorization configuration
Use the IPP user authorization to restrict users that can print with IPP. The
factory default is "off" .

ipp auth {basic|digest|off}
* 'basic" and "digest" are user authorization setting.
e "off" removes a user's authorization.

& Note

O If you select "basic" or "digest", see next section “Entry the IPP User Autho-
rization” for how to configure the user name. Up to ten user names are
available.
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« Configuring IPP user authorization
Use the following command:

ipp user
The following message appears.

Input user number (1 to 10):
Type the number, user name and password.

IPP user name:userl
IPP password:****k&%*
After configuring the settings, the following message appears.

User configuration changed.

Changing the password

Use the passwd command to change the remote maintenance password.

i@klmportant
O Be sure not to forget or lose the password.

& Note
O The default factory password is “password”.

ﬂ Type “passwd”.

msh> passwd

g Type the current password.
01ld password:

B Type the new password.

New password:

@ Note

O The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

O The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.
ﬂ Type the new password once again.

Retype new password:
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Changing the NetBIOS name

Use the hostname command to change the NetBIOS name of the printer.

msh> hostname NetBIOS name of the printer

& Note
O The NetBIOS name consists of up to 13 alphanumeric characters.

O You cannot use a name starting with “RNP” or “rnp”.

WINS

Use the wins command to configure the WINS server.

& Note
O For how to configure the WINS server, see P.105 “Configuring a WINS”.

< WINS configuration
msh> set wins {on|off}
“on” means active and “off” means inactive.

« View settings

The following command displays the IP addresses of the WINS server.
msh> wins

Example output:

L)

wins: primary server 192.168.10.1 secondary server

192.168.10.2

wins server current config: primary server 192.168.10.1
secondary server 192.168.10.2 hostname 123456789abcd

ScopelD
& Note

O The current configuration appears on the second line when DHCP is ac-

tive. When DHCP is not active, there is no second line.

O If the network boot setting is changed to another from DHCP, the WINS
server IP addresses that were saved on the printer may differ from the cur-

rent IP addresses.

« Address configuration
Specify the WINS server IP addresses.
msh> wins {primary|secondary} address

Use “primary” to specify the primary WINS server address, and use “second-

ary” to specify the secondary WINS server address.
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AutoNet

Use the set command to configure AutoNet.
msh> set autonet {on|off}

“on” means active and “off” means inactive.

Changing the password

Use the passwd command to change the remote maintenance password.

ﬂlmportant
O Be sure not to forget or lose the password.

& Note
O The default factory password is “password”.

ﬂ Type “passwd”.

msh> passwd

ﬂ Type the current password.

0ld password:

B Type the new password.

New password:

@ Note

O The password must consist of 3 to 8 alphanumeric characters and symbols.
Upper and lower case characters are considered unique. For example, R is
different from r.

O The password is the same as that used in the configuration of the Network
Interface Board using a Web Browser and that used in the NIB Setup Tool.
If you change a password from telnet, the other passwords are also
changed.

ﬂ Type the new password once again.

Retype new password:
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SNMP

The Network Interface Board functions as a SNMP (Simple Network Manage-
ment Protocol) agent using the UDP and IPX protocols. Using the SNMP man-
ager you can get information about the printer.

The factory default community names are “public” and “admin”. You can get
MIB information using these community names.

/O Reference

For more information about configuring the community name, see P.84 “SN-
MP” in “Remote Maintenance by telnet”.

? Limitation

O The kinds of supported MIBs differ depending on the printer.

< Supported MIBs
e MIB-II
® PrinterMIB
¢ HostResourceMIB
¢ RicohPrivateMIB
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Understanding the Displayed Information

This section describes how to read status information returned by the Network

Interface Board.

Print Job Information

The status of the print job can be viewed using the following commands.

e telnet: Use the status command. = P.83 “Printer status”

Item name Meaning
ID Print request ID.
Source The name of the host requesting the print job.
Process The type of print command.
Status Status of print job.
e Active
Printing or preparing for printing.
¢ Waiting
Waiting to be transferred to the printer.
Time The time when the print request was received.

Print Log Information

This is a record of the most recent ten jobs that have been printed.

This log can be displayed with the following commands.

¢ telnet: Use the prnlog command. = P.83 “Printer status”

Item name Meaning

ID Print request ID.

Source The user name, workstation name or address of the host that sent
the print job.

Process The type of print command used.

Bytes The size of the file in bytes.

Result Communication result.

¢ OK
Indicates that the print job was completed correctly.
* NG
Indicates that the print job was not completed normally.
¢ Canceled
rcp, rsh or lpr print commands were stopped. A problem oc-
curred with the printing application. This message doesn't ap-

pear when ftp or RPRINTER is used.
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Item name Meaning

Time The time when the print request was received.

User Code The user name, workstation name or address of the host that sent
the print job.

Address IP address.

Process The type of print command used.

Print Start Time The time the print process was started.

Print End Time The time the print process was completed.

Open Count The number of print processes that the application made.

Eof Count The reception number of file unit.

Data Size The number of bytes of received data.

Network Statistical Information

Use the following command to view Network Interface Board network statistics.

Detailed information about the words used to describe the status of the Network
Interface Board are described below.

e telnet: Use the info command. = P.83 “Printer status”

Item name Meaning

System elapsed time The time that has passed since the Network Interface Board started.

Total printing time The total time spent in processing the print data.

Total open count The total open (printing process) count that the application re-
quired.

Current connection count | The current number of open connections with the Network Inter-
face Board.

Total connection count The total number of print jobs sent to the Network Interface
Board.

Print error count The number of times the printing process sent an error message.

Access error count The number of times the connection was refused because of the

access control value.

Print request full count The number of times a connection was refused because the num-
ber of print requests exceeded the number of allowed sessions.
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Configuring the Network Interface Board

The Network Interface Board settings can be displayed and confirmed using the
commands below.

¢ telnet : Use the show command. = P.84 “Network Interface Board configuration
settings information”

Item name Meaning

Common
Mode
Protocol Up/Down Up means active, Down means inactive.

AppleTalk
TCP/IP
NetWare
NetBEUI
NVRAM version Internal version number.

Device name

Comment
Location
Contact
Soft switch
AppleTalk
Mode AppleTalk protocol in selection.
Net Network number.
Object Macintosh printer name.
Type The type of printer.
Zone Name of the zone that the printer belongs to.
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Item name Meaning
TCP/1P
Mode Up means active, Down means inactive.
ftp
lpr
rsh
diprint
web
telnet
download
npmp
snmp
ipp
wins
EncapType Frame type.
Network boot Network boot.
Filter Internal parameter.
Max DSTs
Address IP address.
Netmask Subnet mask.
Broadcast Broadcast address.
Gateway Default gateway address.
AccessCtrl Access control address.
AccessMask Access control mask.
Primary WINS Primary WINS server address
Secondary WINS Secondary WINS server address
Time server
Home page URL URL of homepage.
Home page link name URL name of homepage.
Help page URL URL of help page.
SNMP protocol Protocol used with SNMP.
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Item name Meaning

NetWare
Mode (this value is fixed)
EncapType Frame type.
RPRINTER number Remote printer number.
RPRINTER name Remote printer name.
Print server name Print server name.
Fileservername Name of the connect file server.
Context name Context of print server.
Switch

Mode Active mode.

NDS/Bindery (this value is fixed)

Packet negotiation
Print job timeout Time of the job timeout.

NetBEUI
Mode (this value is fixed)
Switch

Mode (this value is fixed)

Direct print (this value is fixed)

Notification Notification of print job completion.
Workgroup name Name of the workgroup.
Computer name Name of the computer.

Comment Comment.
Share name[1] Share name (name of the printer type).
Shell mode Mode of remote maintenance tool.
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Message List

This is a list of messages written to the printer's system log. The system log can

be viewed using the syslog command.

System Log Information

You can use the following methods to view the system log.

¢ telnet: Use the syslog command. = P.84 “System log information”

Message when the Network Interface Board starts or restarts

Network Interface Board Ver.x.x.x

The version number of the Network Interface
Board.

PRINTER SYSTEM “system name” Ver.x.x.x

The system name and version of the printer.

Attach FileServer="file server name”

The printer is attached to “file server name” as
the nearest server.

Current Interface Speed:xxxMbps

The speed of the network (10 Mbps or 100
Mbps).

Current IPX address

The current IPX address.

Frametype="frame type name”

The "frame type name" is configured to be
used on NetWare.

NetBEUI Computer Name="computer name”

The NetBEUI Computer Name is defined as
"computer name".

Start httpd The Web server has been started.
Start npmpd for IPX The npmpd for IPX protocol has been started.
Start npmpd for TCP/IP The npmpd for TCP/IP protocol has been

started.

Start smbd direct print mode(NetBEUI)

You can print from a client on the Windows
network via the print server.

Start snmpd Ver.2.0

The SNMP agent of the displayed version has
been started.

Vendor=, Country=, Lang=

The vendor, the country code, and the lan-
guage.
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NetWare (When the Network Interface Board is started)

< When working as a print server

Access to NetWare server “file server name”
denied. Either there is no account for this
print server on the NetWare server or the
password was incorrect.

Cannot log in to the file server. Confirm that
the print server is registered on the file serv-
er. If a password is specified for the print
server, delete it.

Attach to print queue “print queue name”

Attached to the print queue.

Login to fileserver “file server name”
(“NDS | BINDERY”)

Logged in to the file server with NDS or
BINDERY mode.

Open log file “file name”

The specified log file has been opened.

Printer “printer name” has no queue

The print queue is not assigned to the print-
er. Using NWAdmin, assign the print queue
to the printer, and then restart it.

Print queue “print queue name” cannot be
serviced by printer 0, “print server name”

Print services are not available for the print
queue. Confirm that the volume of the print
queue exists on the specified file server.

The print server received error “error num-
ber” during attempt to log in to the net-
work.Access to the network was
denied.Verify that the print server name and
password are correct.

Cannot log in to the file server. The print
server is not registered or the password is
specified. Register the print server without
specifying a password.

< When working as a remote printer

Cannot create service connection

Cannot establish a connection with the file
server. Your request may exceed the maxi-
mum number of connections that the file
server can deal with at a time.

Cannot find rprinter (“print server name”/
“printer number”)

The printer having the number displayed on
the print server does not exist. Confirm the
number of the printer registered to the print
server.

Establish a connection with the print server,
“print server name”

A connection with the print server has been
established.

No local target for “print server name”

Cannot get routing information about the file
server. If a different frame type is configured
from that used on the network, you should
select "Auto Select" as a frame type.

Required file server (“file server name”) not
found

Cannot find the required file server.

Required print server (“print server name”)
not found

Cannot find the print server. Confirm the
name of the print server.

Unable to attach to print server (“print server
name”

Cannot connect to the print server. The print
server refuses a connection for some reason.
Confirm the configuration of the print serv-
er.
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NetBEUI (When the Network Interface Board is started)

Back to default name (<Computer name>) The same computer name is detected on the
network. As unable to add computer name to
the suffix, Computer name back to default
name. Configure a new computer name that is

unique.
Print session full Cannot accept the print session.
Required computer name (<Computer The same computer name is detected on the
name>) is duplicated name network. The start job determines the comput-

er name by adding the computer name to the
suffix (0,1....). Configure a new computer
name that is unique.

TCP/IP

< When the address is configured

Invalid gateway address The gateway address is not correct for the
specified IP address.

< When using Ipr

filter data error Some data cannot be handled by the filter
option. Confirm the file code and the settings
of the filter option.

lost connection The connection was cut by the other party.
Check the printer to which you requested to
print.

print requests full Cannot accept the print request (max. 5 ses-

sions). Confirm the status of the printer with
telnet, and print it again after the print re-
quest becomes less than 5 sessions.

printer permission denied Cannot get permission to use the printer.
Confirm the access rights with the access
control address and the access control mask.

printer refuse Something is wrong with the printer. Con-
firm the status of the printer.

At the beginning of the message, the IP address of the client is displayed with-
in parentheses.
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< When using rsh, rcp, ftp

7

Can't build data connection: “message’

Cannot establish a connection for data trans-
fer due to the displayed error. Check the ftp
of the workstation that requested the print
job, and start it again. When using ftp, this
message remains only on the system log in-
formation.

cmd_name:Command not supported

The remote shell command using cmd-name
is not supported. You should use only the
print, stat, status, syslog, info, and prnlog
commands. You should access the printer
only with rsh and rcp remote shell com-
mands.

command line too long

The command line is too long.

file_name:No such file or directory

You must use a file name with the stat, sta-
tus, syslog, info, prnlog, and install com-
mands.

filter data error

Some of the data cannot be handled with the
filter option. Confirm the file code and the
settings of the filter option.

get log busy

Another machine is getting the log informa-
tion. You should get it afterwards.

lost connection

The connection was cut by a counterpart.
Check the ftp of the workstation that re-
quested the print job, and start it again.
When using ftp, this message remains only
on the system log information.

no more ftp execute

More than three users at a time cannot log in
using ftp. Since there are three other users
that have already logged in, wait until the
job is finished.

print requests full

Cannot accept the print request.(max. five
sessions) Confirm the status of the printer
with lpq, rsh, rcp, and ftp commands, and
print it again after the number of print re-
quests (sessions) becomes less than five.

printer busy

Cannot get the printer information. Another
user may be accessing it. Wait a few minutes
before trying again.

printer permission denied

Cannot get a permission to use the printer.
Confirm the access right with the access con-
trol address and the access control mask.

printer refuse

Something is wrong with the printer. Con-
firm the status of the printer.

At the beginning of the message, the IP address is displayed in parentheses.

99



100

Appendix

< When using SNMP

Exit snmpd

The agent is complete. Reset the printer or
turn the printer off and on.

recvfrom:packet discarded,length(Reception
packet length)> (Packet size),from addr <Ad-
dress of partner point>

The received packet was ignored since the
length of the packet exceeds the limit. Con-
firm whether the administration station sent
a packet is longer than 1025 bytes.

session <Community name appointed> not
defined

The community name of the received packet
is not defined. Confirm that the community
name of the administration station is the
same as that specified for the printer.

snmpin:Bad use of session <community
Name> from <Address>

The community name of the received packet
is not the same as that of the administration
station. Confirm the community name spec-
ified to the printer.

snmpin:error in snmpdecipher,code (<Error
No.>)

An error occurred with the received packet.
Check if the number of the objects sent from
the administration station is more than 31
and if there are wrong MIB requests.

snmpin:error in snmpservsend,code (<Error
No.>)

Cannot send a response packet. Normally,
this message is followed by the messages be-
low *1 *2.

snmpin:pkt too large,code (<Error num-
ber>)"

The response packet to the request is too big
to send. Reduce the number of the objects
per request.

snmpin:error in sending too large request
back,code (<Error number>),giving up

The packet notifying the error is too big to
send. Reduce the number of the objects per
request.

snmpin:received bad version

The version of the received packet is invalid.
Confirm that the version of the administra-
tion station is version-1(0).

Error numbers in the messages are codes for internal use.

< When using DHCP

Connected DHCP Server(<IP address as-
signed by the DHCP server>)

The IP address is assigned by the DHCP
server.

Current IP address(<Current IP address>)

This IP address assigned by the DHCP serv-
er is used.

DHCEP lease time is infinity

Lease time of the IP address assigned by the
DHCEP server is infinity.

Auto-configured IP address(<Current IP ad-
dress>)

This IP address assigned by AutoNet is
used.
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< When using WINS

WINS Server=<IP address of the WINS serv-
er> NetBIOS Name=<NetBIOS name>

Registering the NetBIOS name of the printer
with the WINS server is complete.

WINS server address 0.0.0.0

The WINS server IP addresses are not speci-
fied. Specify the IP addresses.

WINS name registration/refresh error code
(Error number)

Cannot register or refresh the NetBIOS
name of the printer with a WINS server.

Check if the WINS server IP addresses are
specified correctly.

Confirm that WINS server is available.

Configure a new NetBIOS name that is
unique.

WINS name registration: Server No Re-
sponse

WINS name refresh: Server No Response

There is no reply on registration or refresh
request from the WINS server.

Check if the WINS server IP addresses are
specified correctly.

Confirm that WINS server is available.

WINS wrong scopelD

The wrong scope ID is used.

Configure the correct scope ID.

The Error number is the number that is sent in response to the WINS server

error code.
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Precautions

Please pay attention to the following when using the Network Interface Board.
When configuration is necessary, follow the appropriate procedures below.

Connecting a Dial Up Router to a Network

When the NetWare file server and the printer are on the opposite side of a router,
packets are continuously sent back and forth, possibly causing communications
charges to increase. Because the packet transmission is a specification of Net-
Ware, you need to change the configuration of the router. If the network you are
using does not allow you to configure the router, configure the printer.

Configuring the router

Filter the packets so that they do not pass over the dial up router.

& Note

O The MAC address of the printer doing the filtering is printed on the network
configuration page. For more information about printing the network config-
uration page, see P.108 “Network Configuration Page”.

O For more information about configuring the printer if the router cannot be
configured, see the instructions below.

Configuring the printer with NetWare

ﬂ Following the setup method in this manual, configure the file server.
g Set the frame type for a NetWare environment.

p Reference

For more information about selecting a frame type, see the Setup Guide
that comes with this printer.

Configuring the printer without NetWare

ﬂ While not printing, the Network Interface Board sends packets on the net-
work. Set the NetWare to inactive.

p Reference

For more information about selecting a protocol, see the Setup Guide that
comes with this printer.
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PostScript Printing from Windows

When printing PostScript from Windows, see the Operating Instructions for
RICOH-SCRIPT2 included as a PDF file on the CD-ROM for how to configure
the Network Interface Board and printer driver.

NetWare Printing

Form Feed

You should not configure the form feed on NetWare. The form feed is controlled
by the printer driver on Windows. If the NetWare form feed is configured, the
printer might not print properly. If you want to change the form feed setting, al-
ways configure it on Windows.

e With Windows 95/98/Me, clear the [Form feed] check box on the [Printer Set-
tings] tab in the printer properties dialog box.

e With Windows 2000, clear the [Form feed] check box on the [Neware Settings]
tab in the printer properties dialog box.

e With Windows NT 4.0, clear the [Form feed] check box on the [Neware Settings]
tab in the printer properties dialog box.

Banner Page

You should not configure a banner page on NetWare. If you want to change the
banner page setting, always configure it on Windows.

e With Windows 95/98/Me, clear the [Enable banner] check box on the [Printer
Settings] tab in the printer properties dialog box.

e With Windows 2000, clear the [Enable banner] check box on the [Neware Set-
tings] tab in the printer properties dialog box.

e With Windows NT 4.0, clear the [Enable banner] check box on the [Neware Set-
tings] tab in the printer properties dialog box.

Printing after resetting the printer

After resetting the remote printer, it will be cut off from the print server for about
30-40 seconds before connecting again. Due to the NetWare specification, print
jobs may be accepted, but they will not be printed during this interval.

When using the printer as a remote printer, wait about 2 minutes after resetting
the printer before attempting to print.
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When Using DHCP

Note the following points when using DHCP (Dynamic Host Configuration Pro-
tocol).

Supported systems

Windows 2000 Server, Windows NT Server 4.0 and Netware 5 can be configured
as a DHCP server.

Configure the printer with a reserved IP address

To always assign the same IP address, configure a reserved IP address using the
DHCP server.

& Note

O When multiple DHCP servers are used, reserve the same address with each
DHCP server. The Network Interface Board needs to receive information
from the DHCP server that it contacts.

Follow these steps to configure the printer with a reserved IP address.
ﬂ Start the DHCP manager.

g Select the scope that will be used, and on the [Scope] menu, click [Reserva-
tion].

B Type the 1P address into [IP Address].

ﬂ Type the MAC address of the Network Interface Board into [Unique Identifi-
er].

& Note
O Do not use hyphens to separate the numbers.

O If you do not know the MAC address, it can be found on the network con-
figuration page. = P.108 “Network Configuration Page”

B Type aname and comment into the [Client Name] box and the [Client Comment]
box.

& Note
O For more information about client names, see P.105 “Additional informa-
tion”.

(3 cricx [adal.

An IP address is reserved.

ﬂ Click [Close] to close the dialog box.



Precautions

Additional information

e When you click [Active Lease] on the [Scope] menu of DHCP manager, a list of
client leases appears. When the reserved IP address is not active, the name of
the reservation is the name entered in the Client Name field of the Add Re-
served Clients dialog box. When the reserved IP address becomes active, the
client name changes to the printer name configured by the Network Interface
Board. Only the first 13 letters of the printer name appear here. When you use
the printer with Multidirect Print, use the host name of the printer as the [Cli-
ent Properties] Client Properties dialog box.

¢ When the DHCP server does not assign an IP address, the Network Interface
Board uses 11.22.33.44 as a temporary IP address. You can confirm the print-
er's IP address on the network configuration page.

* Because 11.22.33.44 is a special IP address, you cannot print using this ad-
dress.

¢ When using the DHCP relay agent in a network environment that uses a dial
up router to connect to the Network Interface Board, an increase in commu-
nication fees can occur.

Configuring a WINS

The printer can be configured to register its NetBIOS name with a WINS server
when power is turned on. This enables the NetBIOS name of the printer to be
specified from PortNavi and Multidirect Print even under a DHCP environment.

This section describes how to configure the WINS server.

& Note
O WINS Server is supported with Windows NT 4.0 Server Service Pack 4 or lat-
er, and Windows 2000 Servers WINS Manager.

O For more information about settings of WINS Server, see Windows Help.

O If there is no reply from the WINS Server, the NetBIOS name will be regis-
tered by broadcast.

O The NetBIOS name consists of up to 13 alphanumeric characters.

Using a WWW browser

ﬂ Start the Web browser.

g Point your browser at the URL or IP address of the printer (e.g. “http://
XXX XXX XXX” substituting the Xs with the IP address).

The status of the printer you chose appears on the Web browser.

B Click [Configuration].
The dialog box for entering the password and user name is displayed.
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ﬂ Enter your user name and password, and then click [OK].

To use the factory default account, enter no user name and type "password"
for the password.

B click rrepar.

E Set [WINS] to active and enter the IP address of the WINS server in [Primary
WINS Server] and [Secondary WINS Server].

U click [Refresh).
8 Exit the Web browser.

g Restart the printer.

Using telnet

ﬂ Connect to the remote printer using telnet.

ﬂ Use the "set" command to make WINS active.

msh> set wins on

B Specify the IP addresses (primary and secondary) using the following com-
mands.
msh> wins primary IPaddress
msh> wins secondary IPaddress

& Note
O To confirm the current configuration, use the "show" command.

ﬂ Log out from telnet.

B Restart the printer.

Using DHCP

You can use the printer under a DHCP environment. You can also register the
printer NetBIOS name on a WINS server when it is running.

& Note

O Printers that register their NetBIOS name on a WINS server must be config-
ured for the WINS server.

O Supported DHCP server is Windows NT 4.0 Server Service Pack 4 or later,
Windows 2000 Server and NetWare 5.

O If you do not use WINS server, reserve printer's IP address in DHCP server
so that the same IP address is assigned every time.
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O DHCP relay-agent is not supported. If you use DHCP relay-agent on a net-
work via an ISDN line, it will result in expensive line charges. This is because
your computer connects to the ISDN line whenever a packet is transferred
from the printer.

Using AutoNet

If the printer IP address is not assigned by a DHCP server automatically, a tem-
porary IP address starting with 169.254 which is not used on the network can be
selected automatically by the printer.

& Note

O The IP address assigned by the DHCP server is given priority to that selected
by AutoNet.

O You can confirm the current IP address on the network configuration page.

O When AutoNet is running, the NetBIOS name is not registered on the WINS
server.

When Using the NIB Setup Tool

If the Network Interface Board cannot browse using the TCP/IP protocol, con-
firm that the TCP/IP environment is correctly configured in your computer.

When Using IPP with Multidirect Print

When using IPP with Multidirect Print, note the following:

* The network printer can only receive one print job from Multidirect Print at a
time. While the network printer is printing a job, another user cannot access
the network printer until it completes the job. In this case, Multidirect Print
tries to access the network printer until the retry interval expires.

e If Multidirect Print cannot access the network printer and times out, Multidirect
Print stops sending the print job. In this case, you should cancel the paused sta-
tus from the print queue window. Multidirect Print will resume access the net-
work printer. You can delete the print job from the print queue window, but
canceling a print job that has been printed by the network printer might cause
that the next print job sent from another user not to be printed correctly.

* Ifa printjob that is sent from Multidirect Print is interrupted and the network
printer cancels the job because something went wrong, launch the print job
again.

e Print jobs sent from another computer do not appear in the print queue win-
dow regardless of the protocol.

e If various users send print jobs using Multidirect Print to network printers,
the printing order might not be the order in which the jobs were sent.

e AnIP address cannot be used for the IPP port name because the IP address is
used for the PortNavi port name.
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Network Configuration Page

You can confirm the network information on the network configuration page.

ﬂ Confirm that the printer is online.

ﬂ Hold down the button on the Network Interface Board for two seconds, and

release it.

The network configuration page is printed.

& Note

O If you hold down the button for five seconds, the system log information
is printed. For more information about the meaning of the data printed, see

P.96 “System Log Information”.

O When DHCP is active, “Current value” is displayed as the current config-

uration.

Node Number
Soft Switch
Printer name
Interface Speed :

TCP/IP
IP Address
Netmask
Gateway
AccessCtrl
AccessMask
Auto IP(Nboot)
Mode
EncapType
Primary WINS server

Secondary WINS server:

NetWare (
IPX Address
EncapType
RPRINTER number
Print server name
File server name
Mode

NetBEUI (
Switch
Workgroup name
Computer name
Share name
Current path name
AppleTalk (
Mode
Net
Object

Type
Zone

1. MAC address
2. Printer name

3. TCP/IP
IP address
Subnet mask
Default gateway address

( Up )
: 133.139.146.191

: 255.255.255.000

: 000.000.000.000

: 000.000.000.000

: 000.000.000.000

: DHCP

: 0x0040

: DIX Ethernet II

: 133.139.146.100 (133.139.146.100)

: 0x06
: WORKGROUP
: NET_PRINTER

.k

: 00:00:74:62:7d:d5
: 0x63dc
: NET_PRINTER

0x0000

100Mbps (Switch:Auto, Nvram:Auto)

NVRAM value Current value)
169.254.028.061)
255.255.000.000)

000.000.000.000)

133.139.146.101 (133.139.146.101)

: 7390A448:000074627DD5
: Auto

: 0

: PSERV.NETWORK.DS

: CAREE

: Print server

(printer name)
\\ NET_PRINTER \ (printer name)

: EtherTalk phase 2
: 0x3908

(printer name)

: LaserWriter

*

Access control address

Access control mask

Network boot
(Command boot)
Frame type

*. WINS server addresses are dis-
played when DHCP is active.
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4. NetWare
IPX address
Frame type
Remote printer number
Print server name
Name of the connect file server
Active mode

5. NetBEUI
(this value is fixed)
Workgroup name
Computer name
Share name
Network path name

6. AppleTalk
Network number
Macintosh printer name
The type of printer

Name of the zone that printer belong
to
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Specifications

LAN interface

100BASE-TX, 10BASE-T

Frame type

Ethernetll, IEEE802.2, IEEE802.3, SNAP

Protocol

e TCP/IP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

e IPX/SPX
NetWare 3.12,3.2,4.1, 4.11, 5, IntranetWare

e NetBEUI
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

e IPP
Windows 95
Windows 98
Windows Me
Windows 2000
Windows NT 4.0

s AppleTalk
MacO0S7.6.1~9.0

SNMP

MIB-II, PrinterMIB, HostResourceMIB, RicohPrivateMIB
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install
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NIB Setup Tool, 49
PortNavi, Windows 2000, 20
PortNavi, Windows 95/98/Me, 5
PortNavi, Windows NT 4.0, 37

IP address, 78, 80

IPP, 86,107

L

LAN adapter number (Lana Number), 34
LPR port Printing, 45

M

MAC address, 78

Macintosh, 71

message, 96

MIB, 90

Multidirect Print, 107
Windows 2000, 24
Windows 95/98/Me, 9
Windows NT 4.0, 41

Multidirect Print, install
Windows 2000, 24
Windows 95/98/Me, 9
Windows NT 4.0, 41

Multidirect Print, printer port
Windows 2000, 25
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Windows NT 4.0, 42

Multidirect Print, uninstall
Windows 2000, 25
Windows 95/98/Me, 10
Windows NT 4.0, 42
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Network Interface Board Operating
Instructions, i
NIB Setup Tool, 51
install, 49
install, PRINTER MANAGER FOR
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password, 76, 89
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PortNavi, install
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printer status, 83
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remote printer, setup
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setup
client computer, Windows 2000, 29
client computer, Windows 95/98/Me, 13
client computer, Windows NT 4.0, 46

Setup Guide, i
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subnet mask, 81
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uninstall
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PortNavi, Windows 2000, 21
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PortNavi, Windows NT 4.0, 38

UNIX Supplement, i
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Web Browser, 75
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